Important safety information

Use only the power supply and power supply cord provided with this product or the manufacturer's authorized replacement power supply and power supply cord.

Connect the power supply cord to a properly grounded electrical outlet that is near the product and easily accessible.

Refer service or repairs, other than those described in the user documentation, to a professional service person.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific Lexmark components. The safety features of some parts may not always be obvious. Lexmark is not responsible for the use of other replacement parts.

CAUTION: Do not set up this product or make any electrical or cabling connections, such as the power supply cord or telephone, during a lightning storm.

SAVE THESE INSTRUCTIONS.

Operating system notice

All features and functions are operating system-dependent. For complete descriptions:

- Windows users—See the User's Guide.
- Macintosh users—If your product supports Macintosh, see the Mac Help installed with the printer software.
Contents

Finding information about the printer .................................................................9

Setting up the printer ........................................................................................12
  Checking the box contents ..............................................................................12
  Installing another language control panel ..................................................13

Networking the printer ...................................................................................14
  Installing the printer on a network ..............................................................14
  Installing an internal wireless print server ...................................................14
  Finding your MAC address ...........................................................................15

Learning about the printer ..............................................................................16
  Understanding the parts of the printer .........................................................16
  Using the control panel buttons and menus ..............................................17
    Using the control panel ...........................................................................17
    Using the Copy menu ...............................................................................19
    Using the Scan menu ...............................................................................20
    Using the Photo Card menu ...................................................................21
    Using the PictBridge menu .....................................................................22
    Using the Settings menu .........................................................................23
  Saving settings .............................................................................................25

Learning about the software ..........................................................................27
  Using the printer software .........................................................................27
  Using the Lexmark Imaging Studio ..............................................................27
  Using the Solution Center ...........................................................................28
  Using Printing Preferences .........................................................................30
    Opening Printing Preferences ................................................................30
    Using the Printing Preferences tabs .........................................................30
    Using the Save Settings menu ................................................................31
    Using the I Want To menu .......................................................................31
    Using the Options menu .........................................................................31
  Using the Toolbar .........................................................................................31
  Resetting printer software settings to defaults .........................................32

Loading paper and original documents ..........................................................34
  Loading paper ............................................................................................34
  Loading various paper types ....................................................................34
  Loading original documents on the scanner glass ....................................37
Printing ................................................................. 39
  Printing a document .............................................. 39
  Printing high-quality graphics ................................ 39
  Printing a Web page .............................................. 39
  Printing photos or images from a Web page .......... 40
  Printing collated copies ........................................ 41
  Printing the last page first (reverse page order) .... 41
  Printing transparencies ........................................ 41
  Printing envelopes .............................................. 41
  Printing cards ..................................................... 42
  Printing multiple pages on one sheet ................. 42
  Printing files from a memory card or flash drive ... 43

Working with photos .................................................. 44
  Retrieving and managing photos ............................. 44
    Inserting a memory card ...................................... 44
    Inserting a flash drive ........................................ 45
    Transferring photos from a memory device to the computer .......................... 46
    Transferring all photos from a memory card using the control panel ... 46
    Transferring selected photos from a memory card using the computer .... 47
    Transferring all photos from a CD or flash drive using the computer .... 47
    Transferring selected photos from a CD or flash drive using the computer 48
    Transferring photos from a memory card to a flash drive ....................... 48
  Printing photos using the control panel .................. 49
    Printing photos stored on a memory device using the proof sheet .... 49
    Printing all photos ............................................ 50
    Printing photos by number .................................. 50
    Printing photos by date range ................................ 51
    Printing photos using color effects ....................... 51
    Printing photos from a digital camera using DPOF ................. 52
    Using a PictBridge-enabled digital camera to control printing photos .... 52
  Printing photos using the computer ....................... 53
    Viewing / Printing photos from the Photo Library .......... 53
    Printing photos from a media device using the computer ........ 54
    Printing Photo Packages .................................. 54
  Creating photo projects ....................................... 54
    Creating Photo Greeting Cards ............................. 54
    Creating a Photo Slideshow ................................ 55
    Printing an image as a multiple-page poster ......... 56

Copying .............................................................. 57
  Making a copy .................................................... 57
  Adjusting copy quality ......................................... 57
Troubleshooting..........................................................................................................................77

Setup troubleshooting..................................................................................................................77
Incorrect language appears on the display..................................................................................77
Power button is not lit....................................................................................................................78
Software does not install ............................................................................................................78
Page does not print......................................................................................................................79
Cannot print from digital camera using PictBridge.................................................................80

Print troubleshooting..................................................................................................................81
Partial 4 x 6 in. (10 x 15 cm) photo prints when using a PictBridge-enabled digital camera.....81
Improving print quality .............................................................................................................82
Poor text and graphic quality ....................................................................................................83
Poor quality at the edges of the page .......................................................................................84
Print speed is slow....................................................................................................................85
Partial document or photo prints ...........................................................................................85
Photo smudges............................................................................................................................85
Ink levels seem incorrect............................................................................................................85
Ink levels seem to go down too quickly..................................................................................86

Copy troubleshooting..................................................................................................................86
Copier does not respond .........................................................................................................86
Scanner unit does not close .....................................................................................................86
Poor copy quality.....................................................................................................................87
Partial document or photo copies ..........................................................................................88

Scan troubleshooting..................................................................................................................88
Scanner does not respond .......................................................................................................88
Scan was not successful ........................................................................................................89
Scanning takes too long or freezes the computer ..................................................................89
Poor scanned image quality ..................................................................................................89
Partial document or photo scans ..........................................................................................90
Cannot scan to a computer over a network ..........................................................................90

Jams and misfeeds troubleshooting..........................................................................................90
Paper jam in the printer ............................................................................................................90
Paper jam in the paper support ...............................................................................................91
Paper or specialty media misfeeds.........................................................................................91
Printer does not feed paper, envelopes, or specialty media ..................................................91
Banner paper jams..................................................................................................................92

Memory card troubleshooting...................................................................................................92
Memory card cannot be inserted .............................................................................................93
Nothing happens when memory card is inserted .................................................................93

Error messages..........................................................................................................................94
Alignment Error.......................................................................................................................94
Black Ink Low / Color Ink Low / Photo Ink Low .................................................................94
Cartridge Error (1102, 1203, 1204, or 120F) .......................................................................94
Clear Carrier Jam .....................................................................................................................95
Computer not connected ............................................................................................................................ 96
Could not detect a proof sheet ...................................................................................................................... 96
Error 1104................................................................................................................................................... 96
Left Cartridge Error / Right Cartridge Error............................................................................................... 97
Left Cartridge Incorrect / Right Cartridge Incorrect.................................................................................. 97
Left Cartridge Missing / Right Cartridge Missing .................................................................................... 97
Memory Failure........................................................................................................................................... 97
No images have been selected .................................................................................................................. 98
No photo/paper size selection has been made .......................................................................................... 98
No proof sheet information ......................................................................................................................... 98
No valid photo image files detected........................................................................................................ 98
Only one photo enhancement may be chosen at a time ............................................................................ 98
Only one photo/size selection can be chosen at a time ............................................................................. 98
Photo size error. Photo must fit on page .................................................................................................. 99
PictBridge communications error............................................................................................................ 99
Please remove the camera card ................................................................................................................. 99
Some photos removed from card by host.................................................................................................. 99
There is a problem reading the memory card.......................................................................................... 99
Settings are not saved............................................................................................................................... 99
Change time-out settings.......................................................................................................................... 99
Save settings for future jobs ...................................................................................................................... 99
Resetting to factory default settings........................................................................................................ 99
Removing and reinstalling the software.................................................................................................... 100

Notices........................................................................................................................................................ 101
Edition notice.............................................................................................................................................. 101
Power consumption.................................................................................................................................. 103

Index......................................................................................................................................................... 105
# Finding information about the printer

## Quick Setup sheet

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <em>Quick Setup</em> sheet gives you instructions for setting up hardware and software.</td>
<td>You can find this document in the printer box or on the Lexmark Web site at <a href="http://www.lexmark.com">www.lexmark.com</a>.</td>
</tr>
</tbody>
</table>

## Getting Started booklet

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <em>Getting Started</em> booklet gives you instructions for setting up the printer and some basic instructions for using the printer.</td>
<td>You can find this document in the printer box or on the Lexmark Web site at <a href="http://www.lexmark.com">www.lexmark.com</a>.</td>
</tr>
</tbody>
</table>

**Note:** If your printer supports Macintosh operating systems, see the Mac Help:

1. From the Finder desktop, double-click the Lexmark 3500-4500 Series folder.
2. Double-click the printer Help icon.

## User’s Guide

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
</table>
| The *User’s Guide* gives you instructions for using the printer and other information such as:  
  - Using the software (on Windows operating systems)  
  - Loading paper  
  - Printing  
  - Working with photos  
  - Scanning (if supported by your printer)  
  - Making copies (if supported by your printer)  
  - Faxing (if supported by your printer)  
  - Maintaining the printer  
  - Connecting the printer to a network (if supported by your printer)  
  - Troubleshooting problems with printing, copying, scanning, faxing, paper jams, and misfeeds  
**Note:** If your printer supports Macintosh operating systems, see the Mac Help:  
1. From the Finder desktop, double-click the Lexmark 3500-4500 Series folder.  
2. Double-click the printer Help icon. | When you install the printer software, the *User’s Guide* will be installed.  
1. Click **Start** → **Programs** or **All Programs** → **Lexmark 3500-4500 Series**.  
2. Click *User’s Guide*.  
If the link to the *User’s Guide* is not on your desktop, follow these instructions:  
1. Insert the CD.  
   The installation screen appears.  
   **Note:** If necessary, click **Start** → **Run**, and then type `D:\setup`, where `D` is the letter of your CD-ROM drive.  
2. Click **View User’s Guide (including Setup Troubleshooting)**.  
3. Click **Yes**.  
You can also find this document on the Lexmark Web site at [www.lexmark.com](http://www.lexmark.com). |
# Help

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Help gives you instructions for using the software, if your printer connects to a computer.</td>
<td>While in any Lexmark software program, click <strong>Help</strong>, <strong>Tips → Help</strong>, or <strong>Help → Help Topics</strong>.</td>
</tr>
</tbody>
</table>

## Lexmark Solution Center

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
</table>
| The Lexmark Solution Center software is included on your CD. It installs with the other software, if your printer connects to a computer. | To access the Lexmark Solution Center:  
1. Click **Start → Programs** or **All Programs → Lexmark 3500-4500 Series**.  
2. Select **Lexmark Solution Center**. |

## Customer support

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find (North America)</th>
<th>Where to find (rest of world)</th>
</tr>
</thead>
</table>
| Telephone support | Call us at  
- US: 1-800-332-4120  
  Monday–Friday (8:00 AM–11:00 PM ET)  
  Saturday (Noon–6:00 PM ET)  
- Canada: 1-800-539-6275  
  *English* Monday–Friday (8:00 AM–11:00 PM ET)  
  Saturday (Noon–6:00 PM ET)  
  *French* Monday–Friday (9:00 AM–7:00 PM ET)  
- Mexico: 001-888-377-0063  
  Monday–Friday (8:00 AM–8:00 PM ET)  
**Note:** Support numbers and times may change without notice. For the most recent phone numbers available, see the printed warranty statement that shipped with your printer. | Telephone numbers and support hours vary by country or region.  
Visit our Web site at [www.lexmark.com](http://www.lexmark.com).  
Select a country or region, and then select the Customer Support link.  
**Note:** For additional information about contacting Lexmark, see the printed warranty that shipped with your printer. |
| E-mail support | For e-mail support, visit our Web site: [www.lexmark.com](http://www.lexmark.com).  
1. Click **CUSTOMER SUPPORT**.  
2. Click **Technical Support**.  
3. Select your printer family.  
4. Select your printer model.  
5. From the Support Tools section, click **e-Mail Support**.  
6. Complete the form, and then click **Submit Request**. | E-mail support varies by country or region, and may not be available in some instances.  
Visit our Web site at [www.lexmark.com](http://www.lexmark.com).  
Select a country or region, and then select the Customer Support link.  
**Note:** For additional information about contacting Lexmark, see the printed warranty that shipped with your printer. |
Limited Warranty

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find (US)</th>
<th>Where to find (rest of world)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limited Warranty Information</td>
<td>To view the limitations and conditions of this limited warranty, see the Statement of Limited Warranty included with this printer, or set forth at <a href="http://www.lexmark.com">www.lexmark.com</a>.</td>
<td></td>
</tr>
</tbody>
</table>
| Lexmark International, Inc. furnishes a limited warranty that this printer will be free of defects in materials and workmanship for a period of 12 months after the original date of purchase. | 1 Click CUSTOMER SUPPORT.  
2 Click Warranty Information.  
3 From the Statement of Limited Warranty section, click Inkjet & All-In-One Printers.  
4 Scroll through the Web page to view the warranty. | Warranty information varies by country or region. See the printed warranty that shipped with your printer. |

Record the following information (located on the store receipt and the back of the printer), and have it ready when you contact us so that we may serve you faster:

- Machine Type number
- Serial number
- Date purchased
- Store where purchased
## Setting up the printer

### Checking the box contents

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  Black print cartridge</td>
<td>Cartridges to be installed into the printer.</td>
</tr>
<tr>
<td>2  Color print cartridge</td>
<td><strong>Note:</strong> Cartridge combinations vary depending on the product purchased.</td>
</tr>
<tr>
<td>3  Power cord</td>
<td>Attaches to the power supply port located at the back of the printer.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Your power cord may look different from the one shown.</td>
</tr>
<tr>
<td>4  Installation software CD for Windows</td>
<td>• Installation software for the printer</td>
</tr>
<tr>
<td></td>
<td>• Help</td>
</tr>
<tr>
<td></td>
<td>• <em>User's Guide</em> in electronic format</td>
</tr>
<tr>
<td>5  Installation software CD for Macintosh</td>
<td>• Installation software for the printer</td>
</tr>
<tr>
<td></td>
<td>• <em>Mac Help</em></td>
</tr>
<tr>
<td>6  <em>Getting Started</em></td>
<td>Printed booklet that serves as a guide.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Complete user information (<em>User's Guide</em> or <em>Mac Help</em>) can be found on the installation software CDs.</td>
</tr>
<tr>
<td>7  <em>Quick Setup</em> sheet</td>
<td>Initial setup directions</td>
</tr>
<tr>
<td>8  Installation cable</td>
<td>Connects the printer to the computer temporarily during some methods of installation.</td>
</tr>
</tbody>
</table>
Installing another language control panel

These instructions apply only if you received one or more additional language control panels with the printer.

1. Lift and remove the control panel (if one is installed).

2. Choose the correct control panel for your language.

3. Align the clips on the control panel with the holes on the printer, and then press down.
Networking the printer

For complete networking information, please refer to the Getting Started booklet that came with the product.

Installing the printer on a network

Follow the instructions for the networking method you want to use. Make sure the selected network is set up and working properly, and that all relevant devices are turned on. For more information on your specific network, see your network documentation or consult the person who set up the network.

Installing an internal wireless print server

The printer you purchased may contain an internal wireless print server that allows the printer to be used on a wireless network. If your printer does not have an internal wireless print server already installed, you can purchase one separately. Use the following instructions to install the internal wireless print server:

1. Turn off your printer, and then unplug the power cord from the wall outlet.
   
   **Warning:** Failure to unplug the printer can cause damage to your printer and to the internal wireless print server. Make sure the printer is turned off and the power cord is unplugged from the wall outlet before you proceed.

2. Remove the back cover plate by pushing the tab down and then pulling the cover away from the printer.

3. Unpack the internal wireless print server. Save the packaging materials.
   
   **Warning:** Wireless print servers are easily damaged by static electricity. Touch something metal such as the printer frame before you touch the wireless print server.
4 Align the edges of the internal wireless print server with the guides on the left and right, and then slide the wireless print server into the printer until it snaps into place.

5 Make sure the antenna points up.

6 Attach the adhesive label with the MAC address to the back of the printer. You will need this later to in order to network the printer.

You are now ready to configure the internal wireless print server to work on your wireless network.

Finding your MAC address

In order to complete the network configuration of your printer, you may need the media access control (MAC) address of the printer or print server. The MAC address is a series of letters and numbers located on the back of your printer.

If you purchased the internal wireless print server separately, the MAC address appears on an adhesive label that came with the wireless print server. Attach the adhesive label to your printer so you will be able to find the MAC address when you need it.
## Learning about the printer

### Understanding the parts of the printer

<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper support</td>
<td>Load paper.</td>
</tr>
<tr>
<td>Wi-Fi indicator</td>
<td>Check wireless status:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Off</strong> indicates that the printer is not turned on or that no</td>
</tr>
<tr>
<td></td>
<td>wireless option is installed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Orange</strong> indicates that the printer is ready for wireless</td>
</tr>
<tr>
<td></td>
<td>connection, but not connected.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Orange blinking</strong> indicates that the printer is configured but</td>
</tr>
<tr>
<td></td>
<td>unable to communicate with the wireless network.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Green</strong> indicates that the printer is connected to a wireless</td>
</tr>
<tr>
<td></td>
<td>network.</td>
</tr>
<tr>
<td>PictBridge port</td>
<td>Connect a PictBridge-enabled digital camera or a flash drive to</td>
</tr>
<tr>
<td>Memory card slots</td>
<td>Insert a memory card.</td>
</tr>
<tr>
<td>Control panel</td>
<td>Operate the printer.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Using the control panel” on page 17.</td>
</tr>
<tr>
<td>Paper exit tray</td>
<td>Hold paper as it exits.</td>
</tr>
<tr>
<td>Paper feed guard</td>
<td>Prevent items from falling into the paper slot.</td>
</tr>
<tr>
<td>Paper guide</td>
<td>Keep paper straight when feeding.</td>
</tr>
<tr>
<td>Top cover</td>
<td>Access the scanner glass.</td>
</tr>
<tr>
<td>Scanner glass</td>
<td>Copy or remove an item.</td>
</tr>
</tbody>
</table>
Use the | To
---|---
1 | Scanner unit | Access the print cartridges. |
2 | Print cartridge carrier | Install, replace, or remove a print cartridge. |
3 | Lexmark N2050 (internal wireless print server) | Connect the printer to a wireless network. | **Note:** Only the 4500 Series comes with an internal wireless print server installed. |
4 | USB port | Connect the printer to a computer using a USB cable. |
5 | Power supply with port | Connect the printer to a power source. |

Using the control panel buttons and menus

**Using the control panel**

The display shows:
- Printer status
- Messages
- Menus

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
</table>
| 1 | • Turn the printer on and off.  
• Stop the print, copy, or scan process. |
<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
</table>
| 2 | Copy Mode | Access the copy default screen and make copies.  
**Note:** The mode is selected when the button light is on. |
| 3 | Scan Mode | Access the scan default screen and scan documents.  
**Note:** The mode is selected when the button light is on. |
| 4 | Photo Card | Access the photo default screen and print photos.  
**Note:** The mode is selected when the button light is on. |
| 5 | Settings | Access the settings default screen and change printer settings.  
**Note:** Other button lights are off when this button is selected. |
| 6 | Lighter / Darker | Adjust the brightness of a copy or photo. |
| 7 | | Display the Copy, Scan, or Photo Card menu, depending on which mode is selected. |

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
</table>
| 1 | • Return to the previous screen.  
• Delete a letter or number. |
| 2 | • Decrease a number.  
• Delete a letter or number.  
• Scroll through menus, submenus, or settings on the display. |
| 3 | • Select a menu or submenu item that appears on the display.  
• Feed or eject paper. |
| 4 | • Increase a number.  
• Enter a space between letters or numbers.  
• Scroll through menus, submenus, or settings on the display. |
| 5 | • Cancel a print, copy, or scan job in progress.  
• Exit a menu or submenu, and return to the default copy, scan, or photo card screen.  
• Clear current settings or error messages, and return to default settings. |
Using the Copy menu

To access and navigate the Copy menu:

1. From the control panel, press **Copy Mode**.
   The copy default screen appears.
2. If you do not want to change a setting, press **Start Color** or **Start Black**.
3. If you want to change a setting, press \( \equiv \).
4. Press \( \leftarrow \) or \( \rightarrow \) repeatedly until the menu item you want appears.
5. Press \( \checkmark \).
6. Press \( \leftarrow \) or \( \rightarrow \) repeatedly until the submenu item you want or the setting you want appears.
7. Press \( \checkmark \).
   **Note:** Pressing \( \checkmark \) selects a setting. An * appears next to the selected setting.
8. To go into additional submenus and settings, repeat step 6 and step 7 as needed.
9. If necessary, press \( \equiv \) repeatedly to return to the previous menus and make other setting selections.
10. Press **Start Color** or **Start Black**.

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Start Color</strong> Start a color copy, scan, or photo print job, depending on which mode is selected.</td>
</tr>
<tr>
<td>2</td>
<td><strong>Start Black</strong> Start a black-and-white copy, scan or photo print job, depending on which mode is selected.</td>
</tr>
<tr>
<td>Use this</td>
<td>To</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copies*</td>
<td>Specify how many copies to print.</td>
</tr>
<tr>
<td>Resize*</td>
<td>• Specify the percentage for enlarging or reducing the original copy.</td>
</tr>
<tr>
<td></td>
<td>• Specify a specific copy size.</td>
</tr>
<tr>
<td></td>
<td>• Create a multiple-page poster.</td>
</tr>
<tr>
<td>Lighter / Darker*</td>
<td>Adjust the brightness of a copy.</td>
</tr>
<tr>
<td>Quality*</td>
<td>Adjust the quality of a copy.</td>
</tr>
<tr>
<td>Paper Setup</td>
<td>Specify the size and type of the paper loaded.</td>
</tr>
<tr>
<td>Repeat Image*</td>
<td>Choose how many copies of an image to print on a page.</td>
</tr>
<tr>
<td>Collate</td>
<td>Print one or more copies in the correct order.</td>
</tr>
<tr>
<td>N-Up*</td>
<td>Choose how many pages to print on a page.</td>
</tr>
<tr>
<td>Original Size*</td>
<td>Specify the size of the original document.</td>
</tr>
<tr>
<td>Original Type*</td>
<td>Specify the type of the original document.</td>
</tr>
</tbody>
</table>

* Temporary setting. For information on saving temporary and other settings, see “Saving settings” on page 25.

**Using the Scan menu**

To access and navigate the Scan menu:

1. From the control panel, press **Scan Mode**.
   
The scan default screen appears.

2. Press ▼ or ► repeatedly until the scan destination you want appears.

3. If you do not want to change a setting, press **Start Color** or **Start Black**.

4. If you want to change a setting, press □.

5. Press ▼ or ► repeatedly until the menu item you want appears.

6. Press ✓.

7. Press ▼ or ► repeatedly until the submenu item you want or the setting you want appears.

8. Press ✓.

   **Note:** Pressing ✓ selects a setting. An * appears next to the selected setting.

9. To go into additional submenus and settings, repeat step 7 and step 8 as needed.

10. If needed, press ▼ repeatedly to return to the previous menus and make other setting selections.

11. Press **Start Color** or **Start Black**.
<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality*</td>
<td>Adjust the quality of a scan.</td>
</tr>
<tr>
<td>Original Size*</td>
<td>Specify the size of the original document.</td>
</tr>
</tbody>
</table>

* Temporary setting. For information on saving temporary and other settings, see “Saving settings” on page 25.

**Using the Photo Card menu**

1. If necessary, press **Photo Card**, or insert a memory card or a flash drive into the printer.

2. Press ‹ or › repeatedly until the menu item you want appears.

3. Press √.

4. Press ‹ or › repeatedly until the submenu item you want or the setting you want appears.

5. Press √.

   **Note:** Pressing √ selects a setting. An * appears next to the selected setting.

6. To go into additional submenus and settings, repeat step 4 and step 5 as needed.

7. If necessary, press › repeatedly to return to the previous menus and make other setting selections.

8. Press **Start Color** or **Start Black**.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proof Sheet</td>
<td>Print and then scan a proof sheet:</td>
</tr>
<tr>
<td></td>
<td>• for all photos on the memory card</td>
</tr>
<tr>
<td></td>
<td>• for the most recent 20 photos</td>
</tr>
<tr>
<td></td>
<td>• by date</td>
</tr>
<tr>
<td>Print Photos</td>
<td>Print photos directly from a memory card or flash drive.</td>
</tr>
<tr>
<td>Save Photos</td>
<td>• Save photos stored on a memory card or flash drive to the computer.</td>
</tr>
<tr>
<td></td>
<td>• Copy photos from a memory card to a flash drive.</td>
</tr>
<tr>
<td>Lighter/Darker</td>
<td>Adjust brightness of printed photos.</td>
</tr>
<tr>
<td>Photo Effects¹</td>
<td>Apply automatic image enhancement or color effects to your photos.</td>
</tr>
<tr>
<td>Paper Setup¹, ²</td>
<td>Specify the size and type of the paper loaded.</td>
</tr>
<tr>
<td>Photo Size¹, ²</td>
<td>Specify the size photo you want.</td>
</tr>
<tr>
<td>Layout¹</td>
<td>Select borderless or bordered, center one photo on a page, or specify the number of photos to print on a page.</td>
</tr>
<tr>
<td>Quality¹</td>
<td>Adjust the quality of printed photos.</td>
</tr>
</tbody>
</table>

¹ Setting will return to factory default setting when a memory card or flash drive is removed.
² Setting must be saved individually. For more information, see “Saving Paper Size, Paper Type, and Photo Size settings” on page 22.
Saving Paper Size, Paper Type, and Photo Size settings

1. From the control panel, press **Settings**.
2. Press ➔ or ➙ repeatedly until **Paper Setup** appears.
3. Press √.
4. Press ➔ or ➙ repeatedly until **Paper Size** appears.
5. Press √.
6. Press ➔ or ➙ repeatedly until the size you want appears.
7. Press √.
8. Press ➔ to go to the **Paper Type** submenu.
10. Press ➔ or ➙ repeatedly until the setting type you want appears.
11. Press √.
12. Press ➔ repeatedly until **Defaults** appears.
13. Press √.
14. Press ➔ or ➙ repeatedly until **Photo Print Size** appears.
15. Press √.
16. Press ➔ or ➙ repeatedly until the setting you want appears.
17. Press √.

Using the PictBridge menu

The PictBridge default settings menu lets you select printer settings if you did not specify the settings beforehand on your digital camera. For more information on making camera selections, see the documentation that came with your camera.

1. Connect a PictBridge-enabled digital camera to the printer.
   a. Insert one end of the USB cable into the camera.
      
      **Note:** Use only the USB cable that came with the digital camera.
   b. Insert the other end of the cable into the PictBridge port on the front of the printer.
      
      **Note:** The PictBridge port is marked with the PictBridge symbol.
The message, **PictBridge camera detected. Press ✓ to change settings.** appears on the display.

2 Press ◀ or ▶ repeatedly until the menu item you want appears.

3 Press ✓.

4 Press ◀ or ▶ repeatedly until the submenu item you want or the setting you want appears.

5 Press ✓.

**Note:** Pressing ✓ selects a setting. An * appears next to the selected setting.

6 To go into additional submenus and settings, repeat step 4 and step 5 as needed.

7 If necessary, press ◄ repeatedly to return to the previous menus and make other setting selections.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Setup1, 2</td>
<td>Specify the size and type of paper loaded.</td>
</tr>
<tr>
<td>Photo Size1, 2</td>
<td>Specify the size of printed photos.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you did not specify the photo size beforehand in your digital camera, the default photo sizes are:</td>
</tr>
<tr>
<td></td>
<td>- 4 x 6 (if Letter is your default Paper Size)</td>
</tr>
<tr>
<td></td>
<td>- 10 x 15 cm (if A4 is your default Paper Size, and your country is not Japan)</td>
</tr>
<tr>
<td></td>
<td>- L (if A4 is your default Paper Size, and your country is Japan)</td>
</tr>
<tr>
<td>Layout1</td>
<td>Center one photo on a page, or specify the number of photos to print on a page.</td>
</tr>
<tr>
<td>Quality1</td>
<td>Adjust the quality of printed photos.</td>
</tr>
</tbody>
</table>

1 Setting will return to factory default setting when the PictBridge-enabled digital camera is removed.
2 Setting must be saved individually. For more information, see “Saving Paper Size, Paper Type, and Photo Size settings” on page 22.

**Using the Settings menu**

1 From the control panel, press **Settings**.

2 Press ◀ or ▶ repeatedly until the menu item you want appears.
3 Press \( \checkmark \).

4 Press \(<\) or \(>\) repeatedly until the submenu item you want or the setting you want appears.

5 Press \( \checkmark \).

**Note:** When you choose a value selection, an * appears next to the selected setting.

6 To go into additional submenus and settings, repeat step 4 and step 5 as needed.

7 If necessary, press \( \bigcirc \) repeatedly to return to the previous menus and make other selections.

<table>
<thead>
<tr>
<th>From here</th>
<th>You can</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maintenance</strong></td>
<td><strong>Select:</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Ink Level</strong> to view the ink level of the color cartridge. Press (&lt;) or (&gt;) to view the ink level of the black (or photo) cartridge.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Clean Cartridges</strong> to clean the print cartridge nozzles. For more information, see “Cleaning the print cartridge nozzles&quot; on page 72.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Align Cartridges</strong> to align the cartridge. For more information, see “Aligning print cartridges&quot; on page 72.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Print Test Page</strong> to print a test page.</td>
</tr>
<tr>
<td><strong>Paper Setup</strong></td>
<td>Select the size and type of paper loaded.</td>
</tr>
<tr>
<td><strong>Device Setup</strong></td>
<td><strong>Select:</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Language</strong> to change the language setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Country</strong> to set the default blank paper size and date format being used in your location.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Clear Settings Timeout</strong> to change the timeout feature before the printer, if left unused, resets to the factory default settings. For more information, see “Saving settings&quot; on page 25.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Power Saver</strong> to set the number of minutes before the printer, if left unused, enters the Power Saver mode.</td>
</tr>
<tr>
<td><strong>Defaults</strong></td>
<td><strong>Select:</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Photo Print Size</strong> to choose the size of photo(s) to print.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Set Defaults</strong> to change default settings. For more information, see “Saving settings” on page 25.</td>
</tr>
<tr>
<td><strong>Network Setup</strong></td>
<td><strong>Select:</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Print Setup Page</strong> to print a page that lists the network settings.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reset Network Adapter to Factory Defaults</strong> to reset the wireless network settings.</td>
</tr>
</tbody>
</table>
**Saving settings**

In a setting menu, an * appears next to the default setting. To change the setting:

1. Press ◀ or ▶ repeatedly until the setting you want appears.

2. Press √:
   - To save most settings. An * appears next to the saved setting.
   - To select a temporary setting. An * appears next to the selected setting.

   **Note:** The printer reverts to the default setting of a temporary setting after two minutes of inactivity or if the printer is turned off.

### Temporary settings

| Copy Mode        | – Copies  
|                 | – Resize  
|                 | – Lighter/Darker  
|                 | – Quality  
|                 | – Repeat Image  
|                 | – N-Up  
|                 | – Original Size  
|                 | – Original Type  

| Scan Mode        | – Quality  
|                 | – Original Size  
|                 | – Resize  

| Photo Card       | The following Photo Card settings will not time out after two minutes of inactivity or turning off the power but will return to the factory default settings when a memory card or flash drive is removed.  
|                 | – Photo Effects  
|                 | – Photo Size  
|                 | – Layout  
|                 | – Quality  

To change the timeout feature:

a. Press **Settings**.

b. Press ◀ or ▶ repeatedly until **Device Setup** appears.

c. Press √.

d. Press ◀ or ▶ repeatedly until **Clear Settings Timeout** appears.

e. Press √.

f. Press ◀ or ▶ repeatedly until **Never** appears.

g. Press √.

3. To change one or more temporary settings into new default settings:

a. Press **Settings**.

b. Press ◀ or ▶ repeatedly until **Defaults** appears.
c Press √.
d Press ▼ or ▲ repeatedly until **Set Defaults** appears.
e Press √.
f Press ▼ or ▲ repeatedly until **Use Current** appears.
g Press √.
Learning about the software

This chapter tells how to use the printer with Windows operating systems. If you are using a Macintosh operating system, see the Mac Help:

1. From the Finder desktop, double-click the **Lexmark 3500-4500 Series** folder.
2. Double-click the printer **Help** icon.

Using the printer software

<table>
<thead>
<tr>
<th>Use this software</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Lexmark Imaging Studio</td>
<td>Preview, scan, copy, print, or fax documents or photos.</td>
</tr>
<tr>
<td>The Solution Center</td>
<td>Find troubleshooting, maintenance, and cartridge ordering information.</td>
</tr>
<tr>
<td>Printing Preferences</td>
<td>Select the best print settings for the document you are printing.</td>
</tr>
<tr>
<td>The Toolbar</td>
<td>Create printer-friendly versions of active Web pages.</td>
</tr>
</tbody>
</table>

Using the Lexmark Imaging Studio

To open the Lexmark Imaging Studio Welcome screen, use one of these methods:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the desktop, double-click the <strong>Lexmark Imaging Studio</strong> icon.</td>
<td>1. Click <strong>Start → Programs</strong> or <strong>All Programs → Lexmark 3500-4500 Series</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Lexmark Imaging Studio</strong>.</td>
</tr>
</tbody>
</table>

Click the **Lexmark Imaging Studio** icon for the task you want to complete.

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
<th>Details</th>
</tr>
</thead>
</table>
| ![Scan] | Scan | • Scan a photo or document.  
• Save, edit, or share your photo or document. |
| ![Copy] | Copy | • Copy a photo or document.  
• Reprint or enlarge your photo. |
<p>| ![Fax] | Fax  | Send a photo or document as a fax.                                      |
| ![E-mail] | E-mail | Send a document or photo as an attachment to an e-mail message. |</p>
<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View/Print Photo Library" /></td>
<td>View/Print Photo Library</td>
<td>Browse, print, or share your photos.</td>
</tr>
<tr>
<td><img src="image" alt="Transfer Photos" /></td>
<td>Transfer Photos</td>
<td>Download photos from a memory card, flash drive, CD, or PictBridge-enabled digital camera to the Photo Library.</td>
</tr>
<tr>
<td><img src="image" alt="Photo Greeting Cards" /></td>
<td>Photo Greeting Cards</td>
<td>Make quality greeting cards from your photos.</td>
</tr>
<tr>
<td><img src="image" alt="Photo Packages" /></td>
<td>Photo Packages</td>
<td>Print multiple photos in various sizes.</td>
</tr>
<tr>
<td><img src="image" alt="Slideshow" /></td>
<td>Slideshow</td>
<td>View your photos in motion.</td>
</tr>
<tr>
<td><img src="image" alt="Poster" /></td>
<td>Poster</td>
<td>Print your photos as a multiple-page poster.</td>
</tr>
</tbody>
</table>

From the bottom left corner of the Welcome screen,

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Setup and diagnose printer" /></td>
<td>Setup and diagnose printer</td>
<td>• Check ink levels.</td>
</tr>
<tr>
<td><img src="image" alt="Setup and manage faxes" /></td>
<td>Setup and manage faxes</td>
<td>• Order print cartridges.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Find maintenance information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select other Solution Center tabs for more information, including how to change printer settings and troubleshooting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set printer fax settings for:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Dialing and Sending</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ringing and Answering</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fax Printing/Reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Speed Dial and Group Dial numbers</td>
</tr>
</tbody>
</table>

**Using the Solution Center**

The Solution Center provides help, as well as information about the printer status and ink levels.
To open the Solution Center, use one of these methods:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 From the desktop, double-click the <strong>Lexmark Imaging Studio</strong> icon.</td>
<td>1 Click <strong>Start → Programs or All Programs → Lexmark 3500-4500 Series.</strong></td>
</tr>
<tr>
<td>2 Click <strong>Setup and diagnose printer.</strong> The Solution Center appears with the Maintenance tab open.</td>
<td>2 Select <strong>Solution Center.</strong></td>
</tr>
</tbody>
</table>

The Solution Center consists of six tabs:

<table>
<thead>
<tr>
<th>From here</th>
<th>You can</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Status (Main dialog)</td>
<td>• View the status of the printer. For example, while printing, the status of the printer is <strong>Busy Printing</strong>.</td>
</tr>
<tr>
<td></td>
<td>• View paper type detected.</td>
</tr>
<tr>
<td></td>
<td>• View ink levels and order new print cartridges.</td>
</tr>
<tr>
<td>How To</td>
<td>• Learn how to:</td>
</tr>
<tr>
<td></td>
<td>– Use basic features.</td>
</tr>
<tr>
<td></td>
<td>– Print, scan, copy, and fax.</td>
</tr>
<tr>
<td></td>
<td>– Print projects such as photos, envelopes, cards, banners, iron-on transfers, and transparencies.</td>
</tr>
<tr>
<td></td>
<td>• Find the electronic <strong>User’s Guide</strong> for more information.</td>
</tr>
<tr>
<td></td>
<td>• View ink levels and order new print cartridges.</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>• Learn tips about the current status.</td>
</tr>
<tr>
<td></td>
<td>• Solve printer problems.</td>
</tr>
<tr>
<td></td>
<td>• View ink levels and order new print cartridges.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>• Install a new print cartridge.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Wait until scanning is complete before installing a new print cartridge.</td>
</tr>
<tr>
<td></td>
<td>• View shopping options for new cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Print a test page.</td>
</tr>
<tr>
<td></td>
<td>• Clean to fix horizontal streaks.</td>
</tr>
<tr>
<td></td>
<td>• Align to fix blurry edges.</td>
</tr>
<tr>
<td></td>
<td>• Troubleshoot other ink problems.</td>
</tr>
<tr>
<td></td>
<td>• View ink levels and order new print cartridges.</td>
</tr>
<tr>
<td>Contact Information</td>
<td>• Learn how to contact us by telephone or on the World Wide Web.</td>
</tr>
<tr>
<td></td>
<td>• View ink levels and order new print cartridges.</td>
</tr>
</tbody>
</table>
From here | You can
---|---
Advanced | • Change the appearance of the Printing Status window.
| • Turn printing voice notification on or off.
| • Change network printing settings.
| • Share information with us regarding how you use the printer.
| • Obtain software version information.
| • View ink levels and order new print cartridges.

**Note:** For more information, click **Help** in the lower right corner of the screen.

**Using Printing Preferences**

**Opening Printing Preferences**

Printing Preferences is the software that controls the printing function when the printer is connected to a computer. You can change the settings in Printing Preferences based on the type of project you want to create. You can open Printing Preferences from almost any program:

1. With a document open, click **File → Print**.
2. From the Print dialog, click **Properties, Preferences, Options, or Setup**.

**Using the Printing Preferences tabs**

All of the print settings are on the three main tabs of the Printing Preferences software: Quality/Copies, Paper Setup, and Print Layout.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Choices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality/Copies</td>
<td>• Select a Paper Type setting of “Use printer sensor” or “Use my choice.”</td>
</tr>
<tr>
<td></td>
<td>• Select a Quality/Speed setting of Automatic, Quick Print, Normal, or Photo.</td>
</tr>
<tr>
<td></td>
<td>• Select to print in black and white instead of color.</td>
</tr>
<tr>
<td></td>
<td>• Specify the number of copies to print.</td>
</tr>
<tr>
<td></td>
<td>• Select to collate the job.</td>
</tr>
<tr>
<td></td>
<td>• Specify to print the last page of the job first.</td>
</tr>
<tr>
<td>Tab</td>
<td>Choices</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Paper Setup</td>
<td>• Select a Paper Size for Paper, Envelope, Banner, or Borderless.</td>
</tr>
<tr>
<td></td>
<td>• Select an Orientation of Portrait or Landscape.</td>
</tr>
<tr>
<td>Print Layout</td>
<td>• Select a Layout of Normal, Banner, Mirror, N-up, Poster, Booklet, or</td>
</tr>
<tr>
<td></td>
<td>Borderless.</td>
</tr>
<tr>
<td></td>
<td>• Select a duplexing preference on how the sheets are flipped.</td>
</tr>
</tbody>
</table>

**Using the Save Settings menu**

From the Save Settings menu, you can name and save the current Printing Preferences settings for future use. You can save up to six custom settings.

**Using the I Want To menu**

The “I Want To” menu contains a variety of task wizards (printing a photo, an envelope, a banner, a poster, or printing on both sides of the paper) to help you select the correct print settings for a project.

**Using the Options menu**

Use the “Options” menu to make changes to the Quality Options, Layout Options, and Printing Status Options settings. For more information on these settings, open the tab dialog from the menu, and then click the Help button on the dialog.

The “Options” menu also provides direct links to different parts of the Solution Center as well as software version information.

**Using the Toolbar**

The Toolbar lets you create printer-friendly versions of Web pages.

![Toolbar Image](https://example.com/toolbar.png)

**Note:** The Toolbar launches automatically when you browse the Web using Microsoft Windows Internet Explorer version 5.5 or later.

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
</table>
| ![Lexmark Logo](https://example.com/lexmark.png) | • Select Page Setup options.  
• Select Options to customize the toolbar appearance or select a different setting for printing photos.  
• Access links to the Lexmark Web site.  
• Access Help for additional information.  
• Uninstall the Toolbar. |
<p>| <img src="https://example.com/normal.png" alt="Normal Icon" /> | Print an entire Web page in normal quality. |</p>
<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick</td>
<td>Print an entire Web page in draft quality.</td>
</tr>
<tr>
<td>Black and White</td>
<td>Print an entire Web page in black and white.</td>
</tr>
<tr>
<td>Text Only</td>
<td>Print only the text of a Web page.</td>
</tr>
<tr>
<td>Photos</td>
<td>Print only the photos or images on a Web page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The number of photos or images valid for printing appears next to Photos.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview a Web page before printing.</td>
</tr>
</tbody>
</table>

**Resetting printer software settings to defaults**

*Windows 2000 or Windows XP users only:*

1. Click **Start → Settings → Printers** or **Printers and Faxes**.
2. Right-click the **Lexmark 3500-4500 Series** icon.
3. Click **Printing Preferences**.
4. Click the **Save Settings** menu.
5. From the Restore section, select **Factory Settings (Defaults)**.

*Windows Vista users only:*

1. Click **Control Panel → Printer**.
2. Right-click the **Lexmark 3500-4500 Series** icon.
3. Click **Printing Preferences**.
4 Click the **Save Settings** menu.

5 From the Restore section, select **Factory Settings (Defaults)**.

**Note:** Factory default settings cannot be deleted.
Loading paper and original documents

Loading paper

1 Make sure:
   • You use paper designed for inkjet printers.
   • If you are using photo, glossy, or heavyweight matte paper, you load it with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)
   • The paper is not used or damaged.
   • If you are using specialty paper, you follow the instructions that came with it.
   • You do not force paper into the printer.

2 Before loading paper the first time, slide the paper guides out toward the edges of the paper support.

3 Load the paper vertically in the center of the paper support, and adjust the paper guides to rest against the edges of the paper.

Note: To avoid paper jams, make sure the paper does not buckle when you adjust the paper guides.

Loading various paper types

<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 sheets of plain paper</td>
<td>• The paper is designed for use with inkjet printers.</td>
</tr>
<tr>
<td></td>
<td>• The paper is loaded in the center of the paper support.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the edges of the paper.</td>
</tr>
<tr>
<td>25 sheets of heavyweight matte paper</td>
<td>• The glossy or printable side of the paper faces you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)</td>
</tr>
<tr>
<td>25 sheets of photo paper</td>
<td>• The paper is loaded in the center of the paper support.</td>
</tr>
<tr>
<td>25 sheets of glossy paper</td>
<td>• The paper guides rest against the edges of the paper.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Photos require more drying time. Remove each photo as it exits, and allow it to dry to avoid ink smudging.</td>
</tr>
<tr>
<td>Load up to</td>
<td>Make sure</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>10 envelopes</td>
<td>• The print side of the envelopes faces you.</td>
</tr>
<tr>
<td></td>
<td>• The stamp location is in the upper left corner.</td>
</tr>
<tr>
<td></td>
<td>• The envelopes are designed for use with inkjet printers.</td>
</tr>
<tr>
<td></td>
<td>• The envelopes are loaded in the center of the paper support.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the edges of the envelopes.</td>
</tr>
<tr>
<td><strong>Warning:</strong></td>
<td>Do not use envelopes that have metal clasps, string ties, or metal folding bars.</td>
</tr>
<tr>
<td><strong>Notes:</strong></td>
<td>– Do not load envelopes with holes, perforations, cutouts, or deep embossing.</td>
</tr>
<tr>
<td></td>
<td>– Do not use envelopes that have exposed flap adhesive.</td>
</tr>
<tr>
<td></td>
<td>– Envelopes require more drying time. Remove each envelope as it exits, and allow it to dry to avoid ink smudging.</td>
</tr>
</tbody>
</table>

| 25 sheets of labels | • The print side of the labels faces you.                                |
|                     | • The top of the labels feeds into the printer first.                    |
|                     | • The adhesive on the labels does not extend to within 1 mm of the edge of the label. |
|                     | • You use full label sheets. Partial sheets (with areas exposed by missing labels) may cause labels to peel off during printing, resulting in a paper jam. |
|                     | • The labels are loaded in the center of the paper support.              |
|                     | • The paper guides rest against the edges of the labels.                |
| **Note:**          | Labels require more drying time. Remove each sheet of labels as it exits, and allow it to dry to avoid ink smudging. |

<p>| 50 transparencies  | • The rough side of the transparencies faces you.                       |
|                    | • If the transparencies have a removable strip, each strip faces away from you and down toward the printer. |
|                    | • The transparencies are loaded in the center of the paper support.     |
|                    | • The paper guides rest against the edges of the transparencies.        |
| <strong>Notes:</strong>         | • Transparencies with paper backing sheets are not recommended.          |
|                    | • Transparencies require more drying time. Remove each transparency as it exits, and allow it to dry to avoid ink smudging. |</p>
<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 iron-on transfers</td>
<td>• You follow the loading instructions that came with the iron-on transfers.</td>
</tr>
<tr>
<td></td>
<td>• The print side of the transfers faces you.</td>
</tr>
<tr>
<td></td>
<td>• The transfers are loaded in the center of the paper support.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the edges of the transfers.</td>
</tr>
<tr>
<td>Note:</td>
<td>For best results, load transfers one at a time.</td>
</tr>
<tr>
<td>25 greeting cards</td>
<td></td>
</tr>
<tr>
<td>25 index cards</td>
<td></td>
</tr>
<tr>
<td>25 photo cards</td>
<td></td>
</tr>
<tr>
<td>25 postcards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The print side of the cards faces you.</td>
</tr>
<tr>
<td></td>
<td>• The cards are loaded in the center of the paper support.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the edges of the cards.</td>
</tr>
<tr>
<td>Note:</td>
<td>Photo cards require more drying time. Remove each photo card as it exits, and allow it to dry to avoid ink smudging.</td>
</tr>
<tr>
<td>100 sheets of custom-size paper</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The print side of the paper faces you.</td>
</tr>
<tr>
<td></td>
<td>• The paper size fits within these dimensions:</td>
</tr>
<tr>
<td></td>
<td>Width:</td>
</tr>
<tr>
<td></td>
<td>– 76.2–215.9 mm</td>
</tr>
<tr>
<td></td>
<td>– 3.0–8.5 inches</td>
</tr>
<tr>
<td></td>
<td>Length:</td>
</tr>
<tr>
<td></td>
<td>– 127.0–355.6 mm</td>
</tr>
<tr>
<td></td>
<td>– 5.0–17.0 inches</td>
</tr>
<tr>
<td></td>
<td>• The paper is loaded in the center of the paper support.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the edges of the paper.</td>
</tr>
</tbody>
</table>
Load up to

20 sheets of banner paper

<table>
<thead>
<tr>
<th>Make sure</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You remove all the paper from the paper support before loading the banner paper.</td>
</tr>
<tr>
<td>• You tear off only the number of pages needed to print the banner.</td>
</tr>
<tr>
<td>• You place the required stack of banner paper on the top cover.</td>
</tr>
<tr>
<td>• The leading edge of the banner paper feeds into the printer first.</td>
</tr>
<tr>
<td>• The paper is loaded in the center of the paper support.</td>
</tr>
<tr>
<td>• The paper guides rest against the edges of the paper.</td>
</tr>
</tbody>
</table>

**Loading original documents on the scanner glass**

You can scan and then print photos, text documents, magazine articles, newspapers, and other publications. You can scan a document for faxing.

1. Make sure the computer and the printer are on.
2. Open the top cover.
3 Place the original document or item facedown on the scanner glass in the upper left corner.

4 Close the top cover to avoid dark edges on the scanned image.
Printing

Printing a document
1 Load paper.
2 With a document open, click File → Print.
3 Click Properties, Preferences, Options, or Setup.
4 Adjust the settings.
5 Click OK.
6 Click OK or Print.

Printing high-quality graphics
1 Load paper.
2 With your image open, click File → Print.
3 Click Properties, Preferences, Options, or Setup.
4 Click the Quality/Copies tab.
5 From the Quality/Speed section, select Photo.
6 From the Paper Type section, select Use printer sensor to let the printer select the paper type for you.
   Note: To manually select a paper type, select Use my choice.
7 From the drop-down menu, select a glossy or heavyweight matte paper.
8 Click OK.
9 Click OK or Print.

Printing a Web page
You can use the Toolbar to create a printer-friendly version of any Web page.

   1 Load paper.
   2 Open a Web page using Microsoft Internet Explorer 5.5 or later.
   3 If you want to check or change your print settings:
      a From the toolbar area, click Lexmark → Page Setup.
      b Adjust the print settings.
      c Click OK.
   Note: For additional print setting options, see “Using Printing Preferences” on page 30.
4 If you want to view the Web page before printing:
   a Click Preview.
   b Use the toolbar options to scroll between pages, zoom in or out, or select whether to print text and images or text only.
   c Click:
      • Print
      or
      • Close, and continue to step 5.

5 If needed, select a print option from the Toolbar:
   • Normal
   • Quick
   • Black and White
   • Text Only

Printing photos or images from a Web page

1 Load paper. For best results, use photo or heavyweight matte paper, with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)

2 Open a Web page with Microsoft Internet Explorer 5.5 or later.
   On the Toolbar, the number of photos valid for printing appears next to Photos.
   ![Photos (1)](image)

3 If no number appears next to Photos:
   a From the Lexmark logo drop-down menu, select Options.
   b Select the Advanced tab.
   c Select a lower minimum photo size.
   d Click OK.
      The number of photos valid for printing appears next to Photos.

4 Click Photos.
   The Fast Pics dialog appears.

5 If you want to print all the photos or images using the same settings, select the size you want, the blank paper size in the printer, and the number of copies.

6 If you want to print one photo or image at a time:
   a Click the photos or images you do not want to print to deselect them.
   b To make common editing changes:
      1 Right click the photo or image.
      2 Click Edit.
      3 Make your selections.
      4 Follow the instructions on the screen.
      5 When you are finished making changes, click Done.
      6 Select the size you want, the blank paper size in the printer, and the number of copies.

7 Click Print Now.
Printing collated copies

If you print multiple copies of a document, you can choose to print each copy as a set (collated) or to print the copies as groups of pages (not collated).

<table>
<thead>
<tr>
<th>Collated</th>
<th>Not collated</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Collated Example" /></td>
<td><img src="image2.png" alt="Not Collated Example" /></td>
</tr>
</tbody>
</table>

1. Load paper.
2. With a document open, click File → Print.
3. Click Properties, Preferences, Options, or Setup.
4. From the Quality/Copies tab, select the number of copies to print.
5. Select the Collate Copies check box.
6. If you want to print with reverse page order, select the Print Last Page First check box.
7. Click OK.
8. Click OK or Print.

Printing the last page first (reverse page order)

1. Load paper.
2. With a document open, click File → Print.
3. Click Properties, Preferences, Options, or Setup.
4. From the Quality/Copies tab, select Print Last Page First.
5. Click OK.
6. Click OK or Print.

Printing transparencies

1. Load transparencies.
2. With a document open, click File → Print.
3. Click OK or Print.

Note: To prevent smudging, remove each transparency as it exits, and let it dry before stacking. Transparencies may require up to 15 minutes to dry.

Printing envelopes

1. Load envelopes.
2. From the software application, click File → Print.
3. Click Properties, Preferences, Options, or Setup.
4 From the “I Want To” menu, select **Print on an envelope**.

5 From the Envelope Size list, select the envelope size loaded.

6 Select **Portrait** or **Landscape** orientation.

   **Notes:**
   - Most envelopes use landscape orientation.
   - Make sure the same orientation is also selected in the software application.

7 Click **OK**.

8 Click **OK**.

9 Click **OK** or **Print**.

**Printing cards**

1 Load greeting cards, index cards, or postcards.

2 From the software application, click **File → Print**.

3 Click **Properties**, **Preferences**, **Options**, or **Setup**.

4 Select a Quality/Speed setting.
   
   Select **Photo** for photos and greeting cards and **Normal** for other types of cards.

5 Select the **Paper Setup** tab.

6 Select **Paper**.

7 From the Paper Size list, select a card size.

8 Click **OK**.

9 Click **OK** or **Print**.

   **Notes:**
   - To avoid paper jams, do not force the cards into the printer.
   - To prevent smudging, remove each card as it exits, and let it dry before stacking.

**Printing multiple pages on one sheet**

1 Load paper.

2 With a document open, click **File → Print**.

3 Click **Properties**, **Preferences**, **Options**, or **Setup**.
4 From the Print Layout tab, select N-up.

![N-up Selection](image)

5 Select the number of pages to print on each page.

6 If you want each page image to be surrounded by a border, select Print Page Borders.

7 Click OK.

8 Click OK or Print.

**Printing files from a memory card or flash drive**

**Notes:**

- To print Microsoft Office files, make sure the printer is connected to a computer through USB cable, and both the printer and the computer are on.
- To print photos, the printer may or may not be connected to a computer.

1 Insert a memory card into a card slot or a flash drive into the PictBridge port on the front of the printer.

   If there are only Microsoft Office files stored on the memory card or flash drive, the printer automatically switches to File Print mode. Only Microsoft Office files that have file name extensions DOC, XLS, PPT, PDF, and RTF are recognized.

   **Note:** If there are also photos stored on the memory card or flash drive, the message, *Which would you like to print?* appears on the display.

   **a** If necessary, press < or > repeatedly until *Documents* appears.

   **b** Press ✓.

2 If the document you want to print is in a subfolder within the memory card or flash drive, press ✓ repeatedly until the folder you want appears.

   **Note:** Press ⇧ to return to the previous folder.

3 Press < or > repeatedly until the file name of the document you want to print appears.

4 Press Start Color or Start Black.
Working with photos

- Make sure that the printer settings are set correctly for the photos you wish to print. For information on how to set photo print settings, see “Using the Photo Card menu” on page 21.
- The following print settings will return to the factory default settings when a memory card or flash drive is removed: Photo Effects, Layout, Paper Size, Paper Type, Photo Size, and Quality.
- For best results, use Lexmark Premium Photo Paper or Lexmark Photo Paper.
- To prevent smudging, avoid touching the surface of a printed photo. For best results, remove each printed sheet individually from the paper exit tray, and allow the prints to dry at least 24 hours before stacking, displaying, or storing.

Retrieving and managing photos

Inserting a memory card

1. Insert a memory card.
   - Insert the card with the brand name label facing to the left.
   - If there is an arrow on the card, make sure it points toward the printer.
   - Make sure you connect the memory card to the adapter that came with it before inserting it into the slot.

<table>
<thead>
<tr>
<th>Slots</th>
<th>Memory card</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>xD Picture Card</td>
</tr>
<tr>
<td></td>
<td>Secure Digital</td>
</tr>
<tr>
<td></td>
<td>Mini Secure Digital (with adapter)</td>
</tr>
<tr>
<td></td>
<td>Micro Secure Digital (with adapter)</td>
</tr>
<tr>
<td></td>
<td>MultiMedia Card</td>
</tr>
<tr>
<td></td>
<td>Reduced Size MultiMedia Card (with adapter)</td>
</tr>
<tr>
<td></td>
<td>Memory Stick</td>
</tr>
<tr>
<td></td>
<td>Memory Stick PRO</td>
</tr>
<tr>
<td></td>
<td>Memory Stick Duo (with adapter) or Memory Stick PRO Duo (with adapter)</td>
</tr>
<tr>
<td>2</td>
<td>Compact Flash Type I and Type II</td>
</tr>
<tr>
<td></td>
<td>Microdrive</td>
</tr>
<tr>
<td></td>
<td>MultiMedia Card mobile (with adapter)</td>
</tr>
<tr>
<td></td>
<td>High Capacity Secure Digital (with adapter)</td>
</tr>
</tbody>
</table>

2. Wait for the light located above the memory card slots on the printer to come on. The light blinks to indicate the memory card is being read or is transmitting data.
Warning: Do not touch cables, any network adapter, the memory card, or the printer in the area shown while actively printing, reading, or writing from a memory card. A loss of data can occur. Also, do not remove a memory card while actively printing, reading, or writing from a memory card.

When the printer recognizes that a memory card is installed, the message Memory Card Detected appears. If the printer does not read the memory card, remove and reinsert it. For more information, see “Memory card troubleshooting” on page 92.

Note: The printer recognizes one active memory card at a time. If you insert more than one memory card, a message appears on the display prompting you to remove the memory card that is not in use.

Inserting a flash drive

1 Insert the flash drive into the PictBridge port on the front of the printer.

Note: An adapter may be necessary if your flash drive does not fit directly into the port.

2 Wait for the printer to recognize that a flash drive is installed. When the flash drive is recognized, the message USB Flash Drive Detected appears.

If the printer does not read the flash drive, remove and reinsert it.

Warning: Do not touch cables, any network adapter, the flash drive, or the printer in the area shown while actively printing, reading, or writing from the flash drive. A loss of data can occur. Also, do not remove the flash drive while actively printing, reading, or writing from the flash drive.
Note: The printer recognizes one active media device at a time. If you insert a memory card and a flash drive, a message appears on the display prompting you to designate the device you want the printer to recognize.

Transferring photos from a memory device to the computer using the control panel

If the printer is connected directly to a computer, or connected to a computer through a wireless network connection, you can transfer photos from a memory card or flash drive to the computer.

Notes:
- You cannot transfer photos from a memory device to a computer through an external network adapter.
- The wireless computer may require that you select a computer (and a PIN number if required by that computer).

1 Insert a memory card or a flash drive that contains the images you want to transfer. For more information, see “Inserting a memory card” on page 44 or “Inserting a flash drive” on page 45.

2 Press ◀ or ▶ repeatedly until Save Photos appears.

3 Press ✓.

4 If needed, press ◀ or ▶ repeatedly until Computer appears.

5 Follow the instructions on the computer screen.

Transferring all photos from a memory card using the computer

1 Insert a memory card into the printer with the label facing the printer control panel. If the computer is connected to a wireless network, you may need to select the printer.

   Note: For a network connection, you must manually open the application and select the printer you wish to use.

   The Lexmark Imaging Studio software launches automatically on your computer.

2 Click Automatically save all photos to “My Pictures”.

3 If you want to erase the photos from the memory card, click Yes.

   Note: Make sure all the photos have been copied before you click Yes to erase.

4 Click Done. Remove the memory card to view your transferred photos in the Photo Library.
Transferring selected photos from a memory card using the computer

1 Insert a memory card into the printer with the label facing the printer control panel.
   The Lexmark Imaging Studio software launches automatically on your computer.
   
   **Note:** For a wireless network connection, you must first open the application and then select the printer you wish to use.

2 Click **Select photos to save**.

3 Click **Deselect All**.

4 Click to select the photo(s) you want to transfer.

5 Click **Next**.

6 If you want to save the photos to the default folder, click **Next**.

7 If you want to save the photos in a folder other than the default folder:
   a Click **Browse**.
   b Select the folder you want.
   c Click **OK**.

8 If you want to assign a prefix to all of the photos you just transferred, click the check box and enter a name.

9 Click **Next**.

10 If you want to erase the photos from the memory card, click **Yes**.
   
   **Note:** Make sure all the photos have been copied before you select **Yes** to erase.

11 Click **Done**. Remove the memory card to view your transferred photos in the Photo Library.

Transferring all photos from a CD or flash drive using the computer

1 Insert a CD into the computer or a flash drive into the printer. For more information, see “Inserting a flash drive” on page 45.
   The Lexmark Imaging Studio software launches automatically on your computer.

2 If you are using Windows XP, a “What do you want Windows to do?” screen appears.
   Click **Transfer Photos to your computer using the Lexmark Imaging Studio**.

3 If you are using Windows 2000:
   a From the desktop, double-click the **Lexmark Imaging Studio** icon.
   b Click **Transfer Photos**.

4 Click **Automatically save all photos to “My Pictures”**.

5 Remove the flash drive or CD to view your transferred photos in the Photo Library.
**Transferring selected photos from a CD or flash drive using the computer**

1. Insert a CD into the computer or a flash drive into the printer. For more information, see “Inserting a flash drive” on page 45.

   The Lexmark Imaging Studio software launches automatically on your computer.

2. If you are using Windows XP, a “What do you want Windows to do?” screen appears.

   Click **Transfer Photos to your computer using the Lexmark Imaging Studio**.

3. If you are using Windows 2000:
   a. From the desktop, double-click the **Lexmark Imaging Studio** icon.
   b. Click **Transfer Photos**.

4. Click **Select photos to save**.

5. Click **Deselect All**.

6. Click to select the photo(s) you want to transfer.

7. If you want to save the photos to the default folder, click **Next**.

8. If you want to save the photos in a folder other than the default folder:
   a. Click **Browse**.
   b. Select the folder you want.
   c. Click **OK**.

9. If you want to assign a prefix to all of the photos you just transferred, click the check box and enter a name.

10. Click **Next**.

11. Remove the CD or flash drive to view your transferred photos in the Photo Library.

**Transferring photos from a memory card to a flash drive**

1. Insert a memory card that contains the images you want to transfer. For more information, see “Inserting a memory card” on page 44.

2. Insert a flash drive into the PictBridge port on the front of the printer. For more information, see “Inserting a flash drive” on page 45.

   Which device is to be displayed? appears on the display.

3. Press ◄ or ► repeatedly until **Camera Card** or the specific type of your camera card appears.

4. Press ✓.

5. Press ◄ or ► repeatedly until **Save Photos** appears.

6. Press ✓.

7. If needed, press ◄ or ► repeatedly until the setting you want appears.
Notes:
- If photos on the memory card were taken on more than one date, selections will include Last Date and Date Range.
- To choose a date range, press √ and then press ◀ or ▶ repeatedly until the desired date is displayed. Date ranges are displayed by month and year starting with the most recent month.
- If the computer is also connected, you must select USB as the destination.

8 Press Start Color or Start Black.

Notes:
- If there is not enough memory on the flash drive, a prompt appears on the display.
- Do not remove the flash drive until a message appears on the display indicating that copying is complete.

Printing photos using the control panel

Printing photos stored on a memory device using the proof sheet

1 Load plain letter or A4 size paper.

2 Insert a memory card or flash drive that contains the images you want to print. For more information, see “Inserting a memory card” on page 44 or “Inserting a flash drive” on page 45.

3 Press ◀ or ▶ repeatedly until Proof Sheet appears.

4 Press √.

5 Press ◀ or ▶ repeatedly until Print Proof Sheet appears.

6 Press √.

7 Press ◀ or ▶ to specify which category of photos you want to print.

You can print a proof sheet:
- For all photos on the memory card
- For the 20 most recent photos, if there are 20 or more photos on the card
- By date, if the photos on the card were taken on more than one date

8 Press √.

9 Press √ again.

One or more proof sheets print.

10 Follow the instructions on the proof sheet to select which photos to print, number of copies, red eye reduction, page layout, print options, and paper size.

Note: When making selections, make sure you completely fill in the circles.

11 Load the proof sheet facedown on the scanner glass. For more information, see “Loading original documents on the scanner glass” on page 37.

12 If needed, press ◀ or ▶ repeatedly until Scan Proof Sheet appears.

13 Press √.

14 Press Start Color or Start Black to scan the proof sheet.
15 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.) For more information, see “Loading paper” on page 34.

Note: Make sure the paper matches the size you selected on the proof sheet.

16 Press Start Color or Start Black to print your photos.

Warning: Do not remove the memory card or flash drive, or turn off the printer, until the photos you selected in the photo proof sheet have been printed. The proof sheet becomes invalid when the memory card or flash drive is removed from the printer, or any time the printer is turned off.

Printing all photos

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.) For more information, see “Loading paper” on page 34.

2 Insert a memory card or flash drive that contains the images you want to print. For more information, see “Inserting a memory card” on page 44 or “Inserting a flash drive” on page 45.

3 Press or repeatedly until Print Photos appears.

4 Press √.

5 Press or repeatedly until Print All Photos appears.

6 Press Start Color or Start Black.

The print settings used on the print job are displayed sequentially on the second line of the display.

7 Press Start Color or Start Black again.

Printing photos by number

You can print photos using the numbers assigned to them on a photo proof sheet. If you want to print photos by photo number, you must first print a proof sheet. For more information, see “Printing photos stored on a memory device using the proof sheet” on page 49.

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.) For more information, see “Loading paper” on page 34.

2 Insert a memory card or flash drive that contains the images you want to print. For more information, see “Inserting a memory card” on page 44 or “Inserting a flash drive” on page 45.

3 Press or repeatedly until Print Photos appears.

4 Press √.

5 Press or repeatedly until Photo Number appears.

6 Press √.

7 Press or repeatedly until the photo number you want appears.

8 Press √ to select a photo.

Note: When you select a photo, an asterisk (*) appears to the left of the number on the second line of the display.

9 If you want to select additional photos, press or to reach the number, and then press √
10 Press Start Color or Start Black.

The print settings used on the print job are displayed one at a time on the second line of the display.

11 Press Start Color or Start Black again.

Printing photos by date range

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.) For more information, see “Loading paper” on page 34.

2 Insert a memory card or flash drive that contains the images you want to print. For more information, see “Inserting a memory card” on page 44 or “Inserting a flash drive” on page 45.

3 Press ‹ or › repeatedly until Print Photos appears.

4 Press ✓.

5 Press ‹ or › repeatedly until Date Range appears.

6 Press ✓.

Dates are displayed by month and year starting with the most recent month.

7 Press ‹ or › to select the month you want.

8 Press ✓.

9 Press Start Color or Start Black.

The print settings to be used on the print job are displayed sequentially on the second line of the display.

10 Press Start Color or Start Black again.

Printing photos using color effects

You can use the control panel to apply color effects to your photos.

Note: You can also print photos with color effects using a proof sheet. For more information, see “Printing photos stored on a memory device using the proof sheet” on page 49.

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.) For more information, see “Loading paper” on page 34.

2 Insert a memory card or flash drive that contains the images you want to print. For more information, see “Inserting a memory card” on page 44 or “Inserting a flash drive” on page 45.

3 Press ‹ or › repeatedly until Photo Effects appears.

4 Press ✓.

5 Press ‹ or › repeatedly until the color effect you want appears.

Note: Color effect selections include Sepia, Antique Grey, and Antique Brown.

6 Press ✓.

Note: The color effect applies to all the photos you print until the active memory card or flash drive is removed.
Printing photos from a digital camera using DPOF

Digital Print Order Format (DPOF) is a feature available on some digital cameras. If your camera supports DPOF, you can specify which photos to print, how many of each, and print settings while the memory card is still in the camera. The printer recognizes these settings when you insert the memory card into the printer.

Note: Make sure the photo print settings you select match your current printer settings. For information on changing printer photo settings, see “Using the Photo Card menu” on page 21.

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.) For more information, see “Loading paper” on page 34.

2 Insert a memory card. For more information, see “Inserting a memory card” on page 44.

3 Press or repeatedly until Print Photos appears.

4 Press .

5 Press or repeatedly until Print DPOF appears.

6 Press Start Color or Start Black.

Using a PictBridge-enabled digital camera to control printing photos

You can connect a PictBridge-enabled digital camera to the printer, and use the buttons on the camera to select and print photos.

1 Insert one end of the USB cable into the camera.

   Note: Use only the USB cable that came with the digital camera.

2 Insert the other end of the cable into the PictBridge port on the front of the printer.

   Warning: Do not touch the USB cable, any network adapter, or the printer in the area shown while actively printing from a PictBridge-enabled digital camera. A loss of data can occur. Also, do not remove the USB cable or network adapter while actively printing from a PictBridge-enabled digital camera.
Notes:

- Make sure the PictBridge-enabled digital camera is set to the correct USB mode. For more information, see the camera documentation.
- The printer recognizes one active media device at a time. If you insert more than one media device, a message appears on the display prompting you to designate the device you want the printer to recognize.
- If you have a memory card inserted when you connect a PictBridge-enabled camera, an error message will be displayed telling you to remove one of the devices.
- If the PictBridge connection is successful, the following appears on the printer display: PictBridge camera detected. Press √ to change settings. If any other message appears, see “Error messages” on page 94.
- Values selected within the menu items are the settings used for Pictbridge printing if no explicit selection is made from the camera.

3 Follow the instructions in the camera documentation to select and print photos.

Note: If the printer is turned off while the camera is connected, you must disconnect and then reconnect the camera.

Printing photos using the computer

Note: To print photos or images from a Web page, see “Printing photos or images from a Web page” on page 40.

Viewing / Printing photos from the Photo Library

1 From the desktop, double-click the Lexmark Imaging Studio icon.
2 Click View / Print Photo Library.
3 Click to select the photo(s) you want to print.
4 From the Imaging Studio taskbar located at the bottom of the screen, click Photo Prints.
5 From the Quality drop-down list, select a copy quality.
6 From the Paper Size in Printer drop-down list, select the paper size.
7 To select multiple prints of a photo, or to select photo sizes other than 4 x 6 in. (10 x 15 cm), select the options you want in the table. Use the drop-down list in the last column to view and select other sizes.
8 Click Print Now in the bottom right corner of the screen.
Printing photos from a media device using the computer

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.) For more information, see “Loading paper” on page 34.

2 Insert a CD or media device into the computer.
   a If you are using Windows XP or Windows Vista, a “What do you want Windows to do?” screen appears. Click Transfer Photos to your computer using the Lexmark Imaging Studio.
   b If you are using Windows 2000:
      1 From the desktop, double-click the Lexmark Imaging Studio icon.
      2 Click Transfer Photos.

3 Click Select photos to print.

4 To print all photos, click Print.

5 To print selected photos, click Deselect All.

6 Click to select the photo(s) you want to print.

7 Click Print.

8 From the Quality drop-down list, select a copy quality.

9 From the Paper Size in Printer drop-down list, select the paper size.

10 To select multiple prints of a photo, or to select photo sizes other than 4 x 6 in. (10 x 15 cm), select the options you want in the table. Use the drop-down list in the last column to view and select other sizes.

11 Click Print Now in the bottom right corner of the screen.

12 Remove the CD or media device.

Printing Photo Packages

1 From the desktop, double-click the Lexmark Imaging Studio icon.

2 Click Photo Packages.

3 Click to select the photos you want to include in your photo package.

4 Click Next.

5 From the Quality drop-down list, select a copy quality.

6 From the Paper Size in Printer drop-down list, select the paper size.

7 To select multiple prints of a photo, or to select photo sizes other than 4 x 6 in. (10 x 15 cm), select the options you want in the table. Use the drop-down list in the last column to view and select other sizes.

8 Click Print Now in the bottom right corner of the screen.

Creating photo projects

Creating Photo Greeting Cards

1 From the desktop, double-click the Lexmark Imaging Studio icon.

2 Click Photo Greeting Cards.
3 From the Style tab, click to select a style for your greeting card.

4 From the Photo tab, select and drag a photo into the preview pane on the right side of the screen.

5 Click the text area to be able to add text to your photo greeting card.

6 When you have finished editing your text, click **OK**.

7 If you want to create another photo greeting card using a different style and/or photo, click **Add New Card**, and repeat step 3 on page 55 through step 6 on page 55.

8 If you want to print your photo greeting card, select **Print your Photo Greeting Card** from the Share tab.

9 Select the number of copies from the Copies drop-down list.

10 Select the copy quality from the Quality drop-down list.

11 Select the paper size from the Paper Size in Printer drop-down list.

<table>
<thead>
<tr>
<th>Paper sizes supported</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>210 x 297 millimeters</td>
</tr>
<tr>
<td>Letter</td>
<td>8.5 x 11 inches</td>
</tr>
<tr>
<td>Greeting cards</td>
<td>4 x 8 inches (10.16 x 20.32 centimeters)</td>
</tr>
</tbody>
</table>

12 Click **Print Now**.

13 If you want to e-mail your photo greeting card, click **E-mail your Photo Greeting Card** from the Share tab.

14 From the Send Quality and Speed area of the screen, select the image size.

15 Click **Create E-mail** to create an e-mail message with your photo greeting card(s) attached.

**Creating a Photo Slideshow**

1 From the desktop, double-click the **Lexmark Imaging Studio** icon.

2 Click **Slideshow**.

3 Click and drag your selected photos to the preview pane at the right side of the screen.

4 If you want to scan another photo to put into your slideshow:
   a Place the photo facedown on the scanner glass.
   b Click **File → Add Photo from Scanner**.
   c Repeat this step until all your photos have been scanned.

5 From the Settings tab, select the number of seconds to view each photo in the Time to display each photo drop-down list.

6 If you want to loop (replay) the slideshow, click **Yes**.

7 Click **View Show** at the bottom of the right pane. The slideshow is displayed. Click **Exit Slideshow** on the Slideshow viewer to close the slideshow.

8 From the Share tab, click **Save your slideshow** if you want to save the slideshow to the “My Pictures” directory.

9 Enter a name in the File Name area of the dialog.

10 Click **Save**.

55
11 From the Share tab, click **Print your slideshow** if you want to print your slideshow.

12 From the Quality drop-down list, select a copy quality.

13 From the Paper Size in Printer drop-down list, select the paper size.

14 To select multiple prints of a photo, or to select photo sizes other than 4 x 6 in. (10 x 15 cm), select the options you want in the table. Use the drop-down list in the last column to view and select other sizes.

15 Click **Print Now**.

**Printing an image as a multiple-page poster**

1 Load paper.

2 From the desktop, double-click the **Lexmark Imaging Studio** icon.

3 From the Printing Creative Tasks area of the Welcome screen, click **Poster**.

4 If you are scanning a photo:
   a Place the photo facedown on the scanner glass.
   b Click **File → Add Photo from Scanner**.

5 If you are not scanning a new item, open the folder that contains your photo.

6 Drag the photo to the Print a Multi-Page Poster preview area of the screen.

7 Click **Next Step** at the bottom of the left pane.

8 From the “Paper size to print poster on” drop-down list, select a paper size.

9 From the “Print Quality for poster” drop-down list, select the print quality.

10 From the Poster Size drop-down list, select the poster size.

11 If you want to rotate the poster so that it fits better on the printed pages, click **Rotate 90 degrees**.

12 Click **Print Now** in the bottom right corner of the screen.
Making a copy

1 Load paper.
2 Load an original document facedown on the scanner glass.
3 From the control panel, press Copy Mode.
4 Press Start Color or Start Black.

Adjusting copy quality

Quality specifies the resolution used for the copy job. Resolution involves a dots-per-inch (dpi) count; the higher the dpi count, the higher the resolution and copy quality.

1 Load paper.
2 Load an original document facedown on the scanner glass.
3 If necessary, press Copy Mode.
4 Press .
5 Press or ▶ repeatedly until Quality appears.
6 Press ✓.
7 Press or ▶ repeatedly until the quality you want appears.
8 Press ✓.
9 Press Start Color or Start Black.
Copying photos

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)

2 Place a photo facedown on the scanner glass in the upper left corner. For more information, see “Loading original documents on the scanner glass” on page 37.

3 From the control panel, press Copy Mode.

4 Press ▼.

5 Press ◄ or ► repeatedly until Quality appears.

6 Press ✓.

7 Press ◄ or ► repeatedly until Photo appears.

8 Press ✓.

9 Press ◄ or ► repeatedly until Paper Setup appears.

10 Press ✓.

11 Press ◄ or ► repeatedly until Paper Size appears.

12 Press ✓.

13 Press ◄ or ► repeatedly until the size you want appears.

14 Press ✓.

15 Press ◄ or ► repeatedly until Paper Type appears.

16 Press ✓.

17 Press ◄ or ► repeatedly until the type of paper loaded into the printer appears.

18 Press ✓.

19 Press Start Color or Start Black.

Making borderless copies using the control panel

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)

2 Place a photo facedown on the scanner glass in the upper left corner. For more information, see “Loading original documents on the scanner glass” on page 37.

3 From the control panel, press Copy Mode.

4 Press ▼.

5 Press ◄ or ► repeatedly until Resize appears.

6 Press ✓.

7 Press ◄ or ► repeatedly until Borderless appears.
8 Press √.
9 Press ▼ or ► repeatedly until Paper Setup appears.
10 Press √.
11 Press ▼ or ► repeatedly until Paper Size appears.
12 Press √.
13 Press ▼ or ► repeatedly until the size you want appears.
14 Press √.
15 Press ▼ or ► repeatedly until Paper Type appears.
16 Press √.
17 Press ▼ or ► repeatedly until either Automatic or Photo appears.
18 Press √.
19 Press Start Color or Start Black.

Making a copy lighter or darker
If you want to adjust the look of a copy or photo, you can adjust it to make it lighter or darker.

1 Load paper.
   Note: If you are copying photos, use photo or heavyweight matte paper, with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)
2 Load an original document facedown on the scanner glass.
3 From the control panel, press Copy Mode.
4 Press Lighter/Darker.
5 Press ▼ or ► repeatedly to adjust the slider.
6 Press √.
7 Press Start Color or Start Black.

Collating copies using the control panel
If you print multiple copies of a document, you can choose to print each copy as a set (collated) or to print the copies as groups of pages (not collated).

Collated  Not collated

1 Load paper.
2 Load an original document facedown on the scanner glass.
3 From the control panel, press **Copy Mode**.

4 Press \[\text{ }\].

5 Press \[\text{ }\] or \[\text{ }\] repeatedly until **Collate** appears.

6 Press \[\text{ }\].

7 Press \[\text{ }\] or \[\text{ }\] repeatedly until **On** appears.

   **Note:** You can collate copies only if you did not make any changes in the **Resize** menu.

8 Press **Start Color** or **Start Black**.

   **Note:** If you are using the scanner glass, a message appears prompting you for additional pages.

9 Press \[\text{ }\] to continue copying more pages.

10 After the last page, press \[\text{ }\] or \[\text{ }\] repeatedly until **No** appears.

11 Press \[\text{ }\].

**Repeating an image on one page**

You can print the same image multiple times on one sheet of paper. This option is helpful in creating labels, decals, flyers, and handouts.

1 Load paper.

   **Note:** If you are copying photos, use photo or heavyweight matte paper, with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)

2 Load an original document facedown on the scanner glass.

3 From the control panel, press **Copy Mode**.

4 Press \[\text{ }\].

5 Press \[\text{ }\] or \[\text{ }\] repeatedly until **Repeat Image** appears.

6 Press \[\text{ }\].

7 Press \[\text{ }\] or \[\text{ }\] repeatedly until the number of images you want to print on one page appears.

8 Press **Start Color** or **Start Black**.

**Enlarging or reducing an image**

1 Load paper.

   **Note:** If you are copying photos, use photo or heavyweight matte paper, with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)

2 Load an original document or photo facedown on the scanner glass.

3 From the control panel, press **Copy Mode**.

4 Press \[\text{ }\].

5 Press \[\text{ }\] or \[\text{ }\] repeatedly until **Resize** appears.
6 Press \( \checkmark \).

7 Press \(<\) or \(>\) repeatedly until the setting you want appears.

Notes:

- If you select **Custom Resize**, press and hold \(<\) or \(>\) until the size you want appears and press \( \checkmark \).
- If you select **Borderless**, the printer will reduce or enlarge the document or photo as necessary to print a borderless copy on the paper size you have selected. For best results with this resize setting, use photo paper and set the paper type selection to Automatic or Photo.

8 Press **Start Color** or **Start Black**.

**Copying a document using the computer**

1 Load an original document facedown on the scanner glass.

2 From the desktop, double-click the **Lexmark Imaging Studio** icon.

3 From the left pane of the Welcome screen, click **Copy**.

4 Select the Document option.

5 Click **Start**.

6 From the Copies drop-down list, select the number of copies.

7 From the Quality drop-down list, select the copy quality.

8 From the Paper Size in Printer drop-down list, select the paper size.

9 Select whether you want your document printed in Color, Grayscale, or Black and White by clicking the appropriate option.

10 To adjust the Brightness value, use the Brightness slider.

11 To select a custom print size, enter a number from 25 to 400 in the Print Size box. You can also make the document fit the page by clicking the Fit to Page option.

12 Click **Copy Now** in the bottom right corner of the screen.
Copying a photo using the computer

1. Place the photo facedown on the scanner glass.

2. From the desktop, double-click the **Lexmark Imaging Studio** icon.

3. From the left pane of the Welcome screen, click **Copy**.

4. Select **Photo**.

5. Click **Start**.
   - The photo appears in the right pane.

6. From the Quality drop-down list, select the copy quality.

7. From the Paper Size in Printer drop-down list, select the paper size.

8. To select multiple prints of a photo, or to select photo sizes other than 4 x 6 in. (10 x 15 cm), select the options you want in the table. Use the drop-down list in the last column to view and select other sizes.

9. Click **Copy Now** in the bottom right corner of the screen.
Scanning

Note: If you want to customize scan settings, see “Using the Scan menu” on page 20.

Scanning a document

1. Make sure the printer is connected to a computer, and both the printer and the computer are on.
2. Load an original document facedown on the scanner glass.
3. From the control panel, press Scan Mode.
4. Press ▼ or ► repeatedly until the destination to which you want to scan appears.
5. Press Start Color or Start Black.
6. If you are using a Macintosh operating system, you may need to click Scan from the Scan dialog on the computer screen.
7. If you want to save the scanned image, from the software application, click File → Save As.
8. Enter the file name, format, and location where you want the scanned image saved.
9. Click Save.

Scanning to a computer over a network

1. Make sure:
   • The printer is connected to the network through a print server, and the printer and computer receiving the scan are on.
   • The printer is configured to scan over a network (Direct IP Printing).
2. Load an original document facedown on the scanner glass.
3. From the control panel, press Scan Mode.
4. Press ▼ or ► repeatedly until the computer to which you want to scan is highlighted.
5. Press ✓.
6 Press ◀ or ▶ repeatedly until the scan destination you want appears.
7 Press Start Color or Start Black.

Scanning a document using the computer

1 Load an original document facedown on the scanner glass.

2 From the desktop, double-click the Lexmark Imaging Studio icon.
3 Click Scan.
4 Select the Document option.
5 Click Start.
   The scanned document is loaded into your default word processing application. You can now edit the document.

Scanning text for editing

Use the Optical Character Recognition (OCR) software feature to turn scanned images into text you can edit with a word-processing application.

1 Make sure:
   • The printer is connected to a computer, and both the printer and the computer are on.
   • ABBYY Fine Reader is installed.
2 Load an original document facedown on the scanner glass.
3 From the desktop, double-click the Lexmark Imaging Studio icon.
4 Click Scan.
5 Select the Document option.
6 Click Start.
   The scanned document is loaded into your default word processing application. You can now edit the document.
Scanning images for editing
1 Make sure the printer is connected to a computer, and both the printer and the computer are on.
2 Load an original document facedown on the scanner glass.
3 From the desktop, double-click the Lexmark Imaging Studio icon.
4 Click Scan.
5 Select the Photo or Several Photos option.
6 Click Start.
   You can edit the scanned image.

Scanning a photo to the Photo Library
1 Load a photo facedown on the scanner glass.
2 From the desktop, double-click the Lexmark Imaging Studio icon.
3 Click View / Print Photo Library.
4 From the Photo Library Add tab, click Add New Scan.
5 Select the Photo option.
6 Click Start.
   The photo is placed in the current folder of the Photo Library.

Scanning multiple photos at one time using the computer
1 Place the photos facedown on the scanner glass.

   Note: For best results, place photos with the most space possible between the photos and the edges of the scan area.

2 From the desktop, double-click the Lexmark Imaging Studio icon.
3 Click Scan.
4 Select the **Several Photos** option.

5 Click **Start**.

**Scanning documents or images for e-mailing**

You can e-mail attached images using your default e-mail application.

1 Load an original document facedown on the scanner glass.

2 From the desktop, double-click the **Lexmark Imaging Studio** icon.

3 Click **E-mail**.

4 Select the Photo, Several Photos, or Document option.

5 Click **Start**.

6 If you are scanning a photo, select the Photo Size from the Send Quality and Speed area.

7 Click **Create E-mail** to have your images attached to an e-mail message.

**Removing wavy patterns from scanned photos, magazines, or newspapers**

Descreening helps to remove wavy (moire) patterns from images scanned from magazines or newspapers.

1 Make sure the printer is connected to a computer, and both the printer and the computer are on.

2 Load an original document facedown on the scanner glass.

3 From the desktop, double-click the **Lexmark Imaging Studio** icon.

4 Click **Scan**.

5 Select the **Photo** or **Several Photos** option.

6 Click **Start**.

7 Click the **Advanced** tab.

8 Click **Image Patterns**.

9 To remove the image patterns caused by scanning from magazines or newspapers, click **Remove Patterns**.
10 From the drop-down list, select the patterns to be removed.

11 To reduce stray marks on color photos, click the check box, and then move the slider to the desired value.

12 Click OK. The thumbnail is updated.

**Customizing scan settings using the computer**

1 From the desktop, double-click the **Lexmark Imaging Studio** icon.

2 Click **Scan**.

3 Click **Custom Settings**.

4 Change the settings as needed.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Depth</td>
<td>Select Color, Grey, or Black and White.</td>
</tr>
<tr>
<td>Scan Resolution (Dots Per Inch)</td>
<td>Select a scan resolution value from the drop-down list.</td>
</tr>
</tbody>
</table>
| Size                         | • You can auto-crop the scanned item. Move the slider to the desired setting.  
                              | • You can select the area to be scanned. From the drop-down list, select a paper source. |
| Select area to be scanned    | Select the area to be scanned by choosing a paper size from the drop-down list. |
| Convert the image to text with OCR  | Convert an image to text.                                                |
| Always use these settings when scanning | Make your selections permanent by selecting the check box.              |
Make sure:
- The printer is connected to a computer that is equipped with a fax modem.
- The computer is connected to a working phone line.
- Both the printer and the computer are turned on.

**Sending a fax using the software**

You can scan a document to the computer and then fax it to someone using the software.

1. Load an original document facedown on the scanner glass.
2. From the desktop, double-click the *Lexmark Imaging Studio* icon.
3. From the left pane of the Welcome screen, click *Fax*.
4. Select the Document option.
5. Click **Start**.
6. Enter the recipient information, and then click **Next**.
   - **Note:** A fax number can include up to 64 numbers, commas, periods, and/or these symbols: * # + - ( ).
7. Enter the cover page information, and then click **Next**.
8. If there are any additional documents that you want to send with your fax, add these now, and then click **Next**.
9. To send your fax:
   - Immediately—Select the Send now option.
   - At a scheduled time:
     - Select the “Delay sending until” option.
     - Set a time and date.
10. If you want a paper copy of your fax, select Print a copy of your fax.
11. Click **Send**.
Receiving a fax automatically

1. From the desktop, double-click the **Lexmark Imaging Studio** icon.
2. From the Settings area in the left pane of the Welcome screen, click **Setup and manage faxes**.
3. From the “I Want To” menu, click **Adjust speed dial list and other fax settings**.
4. Click the **Ringing and Answering** tab.
5. From the “Automatically answer incoming calls as a fax” area, select **On** from the Auto Answer drop-down list.
6. To turn the Auto Answer feature on and off at scheduled times, select the settings you want from the drop-down lists.
7. To set the number of telephone rings before the printer automatically receives faxes, select a setting from the “Pick-up on the” drop-down list in the “Answering on your phone line type” area.
8. Click **OK** to save the settings.
Maintaining the printer

Changing print cartridges

*Removing a used print cartridge*

1. Make sure the printer is on.
2. Lift the scanner unit.
   The print cartridge carrier moves and stops at the loading position, unless the printer is busy.
3. Press down on the cartridge carrier lever to raise the cartridge carrier lid.
4. Remove the used print cartridge.

*Note:* If you are removing both cartridges, repeat step 3 and step 4 for the second cartridge.

*Installing print cartridges*

1. If you are installing new print cartridges, remove the sticker and tape from the back and bottom of the cartridges.

*Warning:* Do *not* touch the gold contact area on the back or the metal nozzles on the bottom of the cartridges.
2 Press down on the cartridge carrier levers to raise the cartridge carrier lids.

3 Insert the black cartridge or the photo cartridge in the left carrier. Insert the color cartridge in the right carrier.

4 Close the lids.

5 Close the scanner unit, making sure to keep your hands out from underneath the scanner unit.

The control panel display will prompt you to load paper and press √ to print an alignment page.

Note: The scanner unit must be closed to start a new scan, print, copy, or fax job.
Achieving better print quality

Improving print quality

If you are not satisfied with the print quality of a document, make sure you:

- Use the appropriate paper for the document. If you are printing photos or other high quality images, for best results use Lexmark Premium Photo Paper or Lexmark Photo Paper.
- Use a paper that is a heavier weight or bright white.
- Select a higher print quality.

If the document still does not have the print quality you want, follow these steps:

1. Align the print cartridges. For more information, see “Aligning print cartridges” on page 72.
   
   If print quality has not improved, continue to step 2.

2. Clean the print cartridge nozzles. For more information, see “Cleaning the print cartridge nozzles” on page 72.
   
   If print quality has not improved, continue to step 3.

3. Remove and reinsert the cartridges. For more information, see “Removing a used print cartridge” on page 70 and “Installing print cartridges” on page 70.
   
   If print quality has not improved, continue to step 4.

4. Wipe the print cartridge nozzles and contacts. For more information, see “Wiping the print cartridge nozzles and contacts” on page 73.
   
   If print quality is still not satisfactory, replace the cartridge. For more information, see “Ordering supplies” on page 74.

Aligning print cartridges

1. Load plain paper.

2. From the control panel, press Settings.

3. Press  or  repeatedly until Maintenance appears.

4. Press .

5. Press  or  repeatedly until Align Cartridges appears.

6. Press .

   An alignment page prints.

If you aligned the cartridges to improve print quality, print your document again. If print quality has not improved, clean the print cartridge nozzles.

Cleaning the print cartridge nozzles

1. Load plain paper.

2. Press Settings.

3. Press  or  repeatedly until Maintenance appears.

4. Press .
5 Press ▼ or ▲ repeatedly until **Clean Cartridges** appears.

6 Press ✓.
A page prints, forcing ink through the print cartridge nozzles to clean them.

7 Print the document again to verify that the print quality has improved.

8 If print quality has not improved, try cleaning the nozzles up to two more times.

**Wiping the print cartridge nozzles and contacts**

1 Remove the print cartridges.
2 Dampen a clean, lint-free cloth with water.
3 Gently hold the cloth against the nozzles for about three seconds, and then wipe in the direction shown.

4 Using another clean section of the dampened cloth, gently hold the cloth against the contacts for about three seconds, and then wipe in the direction shown.

5 With another clean section of the dampened cloth, repeat step 3 and step 4.
6 Let the nozzles and contacts dry completely.
7 Reinsert the print cartridges.
8 Print the document again.

9 If the print quality does not improve, clean the print nozzles. For more information, see “Cleaning the print cartridge nozzles” on page 72.
10 Repeat step 9 up to two more times.

11 If print quality is still not satisfactory, replace the print cartridges.

Preserving the print cartridges

- Keep a new cartridge in its packaging until you are ready to install it.
- Do not remove a cartridge from the printer except to replace, clean, or store it in an airtight container. The cartridges do not print correctly if left exposed for an extended period of time.
- Keep the photo cartridge in its own storage unit when not in use.

Cleaning the scanner glass

1 Dampen a clean, lint-free cloth with water.

2 Gently wipe the scanner glass clean.

Note: Make sure all ink or corrective fluid on a document is dry before placing the document on the scanner glass.

Ordering supplies

Ordering print cartridges

Lexmark 3500-4500 Series models (except Lexmark 3580 and Lexmark 4580)

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
<th>Average cartridge standard page yield is up to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black cartridge</td>
<td>23A</td>
<td>215</td>
</tr>
<tr>
<td>Black cartridge²</td>
<td>23</td>
<td>215</td>
</tr>
<tr>
<td>High yield black cartridge</td>
<td>34</td>
<td>550</td>
</tr>
<tr>
<td>Color cartridge</td>
<td>24A</td>
<td>185</td>
</tr>
<tr>
<td>Color cartridge²</td>
<td>24</td>
<td>185</td>
</tr>
<tr>
<td>High yield color cartridge</td>
<td>35</td>
<td>500</td>
</tr>
<tr>
<td>Photo cartridge</td>
<td>31</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

1 Values obtained by continuous printing. Declared yield value in accordance with ISO/IEC 24711 (FDIS).
2 Licensed Return Program Cartridge

Lexmark 3580 and Lexmark 4580 models
### Ordering paper and other supplies

To order supplies or to locate a dealer near you, visit our Web site at [www.lexmark.com](http://www.lexmark.com).

**Notes:**
- For best results, use only Lexmark print cartridges.
- For best results when printing photos or other high-quality images, use Lexmark photo papers.

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color cartridge</td>
<td>2</td>
</tr>
<tr>
<td>Black cartridge</td>
<td>3</td>
</tr>
<tr>
<td>Photo cartridge</td>
<td>31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB cable</td>
<td>1021294</td>
</tr>
<tr>
<td>Lexmark N2050 (Internal wireless print server)</td>
<td>For more information, go to <a href="http://www.lexmark.com">www.lexmark.com</a>.</td>
</tr>
</tbody>
</table>

**Note:** If your printer did not come with an internal wireless print server already installed, installing the Lexmark N2050 in the printer lets you print and scan on a wireless network.

<table>
<thead>
<tr>
<th>Paper</th>
<th>Paper size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lexmark Premium Photo Paper</td>
<td>• Letter</td>
</tr>
<tr>
<td></td>
<td>• A4</td>
</tr>
<tr>
<td></td>
<td>• 4 x 6 in.</td>
</tr>
<tr>
<td></td>
<td>• 10 x 15 cm</td>
</tr>
<tr>
<td></td>
<td>• L</td>
</tr>
<tr>
<td>Lexmark Photo Paper</td>
<td>• Letter</td>
</tr>
<tr>
<td></td>
<td>• A4</td>
</tr>
<tr>
<td></td>
<td>• 4 x 6 in.</td>
</tr>
<tr>
<td></td>
<td>• 10 x 15 cm</td>
</tr>
<tr>
<td>Lexmark PerfectFinish™ Photo Paper</td>
<td>• Letter</td>
</tr>
<tr>
<td></td>
<td>• A4</td>
</tr>
<tr>
<td></td>
<td>• 4 x 6 in.</td>
</tr>
<tr>
<td></td>
<td>• 10 x 15 cm</td>
</tr>
<tr>
<td></td>
<td>• L</td>
</tr>
</tbody>
</table>

**Note:** Availability may vary by country or region.

For information on how to purchase Lexmark Premium Photo Paper, Lexmark Photo Paper, or Lexmark PerfectFinish Photo Paper in your country or region, go to [www.lexmark.com](http://www.lexmark.com).

### Using genuine Lexmark print cartridges

Lexmark printers, print cartridges, and photo paper are designed to perform together for superior print quality.
If you receive an Out of Original Lexmark Ink message, the original Lexmark ink in the indicated cartridge(s) has been depleted.

If you believe you purchased a new, genuine Lexmark print cartridge, but the Out of Original Lexmark Ink message appears:

1. Click Learn More on the message.
2. Click Report a non-Lexmark print cartridge.

To prevent the message from appearing again for the indicated cartridge(s):
- Replace your cartridge(s) with new Lexmark print cartridge(s).
- If you are printing from a computer, click Learn more on the message, select the check box, and click Close.

Lexmark's warranty does not cover damage caused by non-Lexmark ink or print cartridges.

**Refilling a print cartridge**

The warranty does not cover repair of failures or damage caused by a refilled cartridge. Lexmark does not recommend use of a refilled cartridge. Refilling a cartridge can affect print quality and may cause damage to the printer. For best results, use Lexmark supplies.

**Recycling Lexmark products**

To return Lexmark products to Lexmark for recycling:

2. Follow the instructions on the computer screen.
Incorrect language appears on the display

These are possible solutions. Try one of the following:

Change the language selection during initial setup

After you select a language, Language appears again on the display. To change the selection:

1 Press ◀ or ▶ repeatedly until the language you want appears on the display.
2 Press ✔️ to save.

Select a different language after initial setup

1 From the control panel, press Settings.
2 Press ◀ or ▶ repeatedly until Device Setup appears.
3 Press ✔️.
4 Press ◀ or ▶ repeatedly until Language appears.
5 Press ✔️.
6 Press ◀ or ▶ repeatedly until the language you want appears on the display.
7 Press ✔️ to save.

Note: If you cannot understand the language on the display, see “Resetting to factory default settings” on page 99.
Power button is not lit
These are possible solutions. Try one or more of the following:

Press power button
Make sure the printer is on by pressing .

Disconnect and reconnect the power cord
1. Disconnect the power cord from the wall outlet, and then from the printer.
2. Plug the cord all the way into the power supply on the printer.

3. Plug the cord into an electrical outlet that other electrical devices have been using.
4. If the light is not on, press .

Software does not install
These are possible solutions. Try one or more of the following:

Check your operating system
The following operating systems are supported: Windows 2000, Windows XP, Windows Vista, and Mac OS X.

Note: Windows 2000 users should use Service Pack 3 or later.

Check your system requirements
Check that your computer meets the minimum system requirements listed on the printer box.

Check USB connection
1. Check the USB cable for any obvious damage.
2. Firmly plug the square end of the USB cable into the back of the printer.
3. Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the USB symbol.

Check wireless connection
Check that the Wi-Fi indicator light is on. For more information see, “Understanding the parts of the printer” on page 16.

Note: Only the 4500 Series comes with an internal wireless print server installed.
Reinstall the software
1. Turn off and then restart your computer.
2. Click Cancel on all New Hardware Found screens.
3. Insert the CD, and then follow the instructions on the computer screen to reinstall the software.

Reconnect power supply
1. Press 🌌 to turn the printer off.
2. Disconnect the power cord from the wall outlet.
3. Gently remove the power supply from the printer.
4. Reconnect the power supply to the printer.
5. Plug the power cord into the wall outlet.
6. Press 🌌 to turn the printer on.

Disable anti-virus programs
1. Close all open software applications.
2. Disable any anti-virus programs.
3. Double-click the My Computer icon.
   In Windows XP, click Start to access the My Computer icon.
4. Double-click the CD–ROM drive icon.
5. If necessary, double-click setup.exe.
6. Follow the instructions on the computer screen to install the software.

Uninstall and reinstall software
Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 100.

Page does not print
These are possible solutions. Try one or more of the following:

Check messages
If an error message is displayed, see “Error messages” on page 94.

Check power
If the 🌌 light is not on, see “Power button is not lit” on page 78.

Reload paper
Remove and then load paper.

Check ink
Check the ink levels, and install new print cartridges if necessary.
Check cartridges

1. Remove the print cartridges.
2. Make sure the sticker and tape have been removed.
3. Reinsert the cartridges.

Check printer default and pause settings

1. Click:
   - In Windows XP (default Start menu): Start → Printers and Faxes.
   - In Windows XP (Classic Start menu): Start → Settings → Printers and Faxes.
   - In Windows Vista (default Start menu): Control → Printers (under Hardware and Sound).
   - In Windows Vista (Classic Start menu): Control → Printers.
2. Double-click the printer queue device.
3. Click Printer.
   - Make sure no check mark appears next to Pause Printing.
   - If a check mark does not appear next to Set As Default Printer, you must select the print queue device for each file you want to print.

Reconnect power supply

1. Press \(\text{\textcircled{O}}\) to turn the printer off.
2. Disconnect the power cord from the wall outlet.
3. Gently remove the power supply from the printer.
4. Reconnect the power supply to the printer.
5. Plug the power cord into the wall outlet.
6. Press \(\text{\textcircled{O}}\) to turn the printer on.

Removing and reinstalling the software

Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 100.

Cannot print from digital camera using PictBridge

These are possible solutions. Try one or more of the following:

Enable PictBridge printing from camera

Enable PictBridge printing on the camera by selecting the correct USB mode. For more information, see the digital camera documentation.
Make sure the camera is a PictBridge-enabled digital camera

1 Disconnect the camera.

2 Connect a PictBridge-enabled digital camera to the PictBridge port. See the digital camera documentation to determine whether it is PictBridge-enabled.

Check USB cable
Use only the USB cable that came with the camera.

Remove memory cards
Remove any memory cards from the printer.

Check messages
If an error message appears on the display, see “Error messages” on page 94.

Print troubleshooting
- “Partial 4 x 6 in. (10 x 15 cm) photo prints when using a PictBridge-enabled digital camera” on page 81
- “Improving print quality” on page 82
- “Poor text and graphic quality” on page 83
- “Poor quality at the edges of the page” on page 84
- “Print speed is slow” on page 85
- “Partial document or photo prints” on page 85
- “Photo smudges” on page 85
- “Ink levels seem incorrect” on page 85
- “Ink levels seem to go down too quickly” on page 86

Partial 4 x 6 in. (10 x 15 cm) photo prints when using a PictBridge-enabled digital camera

Make sure photo size and paper size are set correctly

The printer displays the Paper/Photo Size Error when your chosen photo size does not match the paper size that is set. This typically happens when you are trying to print from your PictBridge-enabled digital camera. You may have left the printer control panel Photo Size menu item setting at 8.5 x 11 in. or 5 x 7 in. size, but your camera has a print size of 4 x 6 in. or L. You need to make sure your chosen photo size on the printer is 4 x 6 in. or 10 x 15 cm, depending on the typically used photo size for your country or region.

- Make sure the 4 x 6 in. (10 x 15 cm) photo paper is loaded correctly in the paper support.
- If your camera lets you change the print size setting, change the print size selection to 4 x 6 in. (10 x 15 cm) on the PictBridge-enabled digital camera.
- If your camera does not allow you to change the paper size setting, use the control panel to change the paper size to 4 x 6 in. (10 x 15 cm).

1 Insert the USB cable that came with your camera to the camera, and insert the other end into the PictBridge port on the front of the printer.

2 Turn the camera on and choose your first photo using the camera control panel.

3 Wait for PictBridge Printing to appear on the display of the printer control panel.

Note: If Paper/Photo Size Error appears, press ✗ to clear the error message.

4 Press ☑.
5 Press or repeatedly until **Photo Size** appears.

6 Press ✓.

7 Press or repeatedly until **4 x 6 in. or 10 x 15 cm** appears.

8 Press ✓.

9 Press or repeatedly until **Paper Setup** appears.

10 Press ✓.

11 Press or repeatedly until **Paper Size** appears.

12 Press ✓.

13 Press or repeatedly until **10 x 15 cm** appears.

14 Press ✓.

15 Press **Start Color** or **Start Black**.

**Improving print quality**

These are possible solutions. Try one or more of the following:

**Check paper**

- Use the appropriate paper for the document. If you are printing photos or other high quality images, for best results use Lexmark photo papers.
- Use a paper that is a heavier weight or bright white.

**Select a higher print quality**

1 Depending on your print job, press **Copy Mode**, **Scan Mode**, or **Photo Card**.

2 Press ●.

3 Press or repeatedly until **Quality** appears.

4 Press ✓.

5 Press or repeatedly until the quality you want appears.

6 Press ✓.

**Check print cartridges**

If the document still does not have the print quality you want, follow these steps:

1 Align the print cartridges. For more information, see “Aligning print cartridges” on page 72.
   
   If print quality has not improved, continue to step 2.

2 Clean the print cartridge nozzles. For more information, see “Cleaning the print cartridge nozzles” on page 72.
   
   If print quality has not improved, continue to step 3.
3 Remove and reinsert the print cartridges. For more information, see “Removing a used print cartridge” on page 70 and “Installing print cartridges” on page 70.

If print quality has not improved, continue to step 4.

4 Wipe the print nozzles and contacts. For more information, see “Wiping the print cartridge nozzles and contacts” on page 73.

If print quality is still not satisfactory, replace the print cartridges. For more information, see “Ordering supplies” on page 74.

**Poor text and graphic quality**

- Blank pages
- Dark print
- Faded print
- Incorrect colors
- Light and dark bands in print
- Skewed lines
- Smudges
- Streaks
- White lines in print

These are possible solutions. Try one or more of the following:

**Check ink**

Check the ink levels, and install new print cartridges if necessary.

**Review steps to improve print quality**

See “Improving print quality” on page 82.

**Remove sheets as they are printed**

To avoid ink smudging when you are working with the following media, remove each sheet as it exits, and allow it to dry:

- Documents with graphics or images
- Photo paper
- Heavyweight matte or glossy paper
- Transparencies
- Labels
- Envelopes
- Iron-on transfers

**Note:** Transparencies may take up to 15 minutes to dry.

**Use a different brand of paper**

Each paper brand accepts ink differently and prints with color variations. If you are printing photos or other high-quality images, for best results use Lexmark Premium Photo Paper or Lexmark Photo Paper.

**Check paper condition**

Use only new, unwrinkled paper.

**Removing and reinstalling the software**

Software may not be installed correctly. For more information, see “Removing and reinstalling the software” on page 100.
**Poor quality at the edges of the page**

These are possible solutions. Try one or more of the following:

**Check minimum print settings**

Unless you are using the borderless feature, use these minimum print margin settings:

- Left and right margins:
  - 6.35 mm (0.25 in.) for letter size paper
  - 3.37 mm (0.133 in.) for all paper sizes except letter
- Top margin: 1.7 mm (0.067 in.)
- Bottom margin: 12.7 mm (0.5 in.)

**Select the Borderless print feature**

1. From the software application, click **File → Print**.
2. Click **Properties, Preferences, Options, or Setup**.
3. Click **Print Layout**.
4. Click **Borderless**.

**Select the Borderless resize feature (when copying)**

1. Press <-.
2. Press ◀ or ▶ repeatedly until **Resize** appears.
3. Press √.
4. Press ◀ or ▶ repeatedly until **Borderless** appears.
5. Press √.
6. Press **Start Color** or **Start Black**, or press <- to return to the Copy menu to select the number of copies you want.

**Select the Borderless photo feature (when printing photos)**

1. Press <-.
2. Press ◀ or ▶ repeatedly until **Layout** appears.
3. Press √.
4. Press ◀ or ▶ repeatedly until **Borderless** appears.
5. Press √.
6. Press **Start Color** or **Start Black**, or press <- to return to the Photo Card menu to select the photos you want to print.

**Make sure you use photo paper**

Borderless printing requires photo paper. Small margins are printed when you select the Borderless feature when you are printing on plain paper.
Make sure the paper size matches the printer setting

1. From the software application, click **File ➔ Print**.
2. Click **Properties, Preferences, Options**, or **Setup**.
3. Click **Paper Setup**.
4. Check the paper size.

**Print speed is slow**

These are possible solutions. Try one or more of the following:

**Maximize computer processing speed**
- Close all applications not in use.
- Minimize the number and size of graphics and images in the document.
- Remove as many unused fonts as possible from your system.

**Add memory**

Consider purchasing more RAM.

**Select a lower print quality**

1. From the software application, click **File ➔ Print**.
2. Click **Properties, Preferences, Options**, or **Setup**.
3. Click **Quality/Copies**.
4. From the Quality/Speed area, select a lower print quality.

**Removing and reinstalling the software**

For more information, see “Removing and reinstalling the software” on page 100.

**Partial document or photo prints**

These are possible solutions. Try one or more of the following:

**Check document placement**

Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.

**Check paper size**

Make sure the paper size being used matches the document or photo size you selected.

**Photo smudges**

To prevent smudging, avoid touching the surface of a printed photo. For best results, remove each printed sheet individually from the paper exit tray, and allow the prints to dry at least 24 hours before stacking, displaying, or storing.

**Ink levels seem incorrect**

There are possible solutions. Try one or more of the following:

**Are you printing graphics or photos?**

When you print documents with a large number of graphics, or with the Photo Quality/Speed setting, the printer uses more ink. The type of documents you print and the print quality you select affect the amount of ink the printer uses.
Are you printing a large file?

The ink levels displayed in the printer software are not updated during a print job; they represent the ink level at the beginning of a print job. The ink levels may seem inconsistent in the Printing Status window when you are printing a large file.

**Ink levels seem to go down too quickly**

These are possible solutions. Try one or more of the following:

**Are you printing photos or documents with a large number of graphics?**

Because photos and graphics require more ink than text documents, ink usage increases when you print photos or graphics.

**Are you printing with the Best Quality/Speed setting?**

To reduce ink usage, select **Best** only when you are printing on photo or heavyweight matte paper. All other paper types print best at a lower Quality/Speed setting. Use the Quick Print or Normal setting to print most text documents.

**Copy troubleshooting**

- “Copier does not respond” on page 86
- “Scanner unit does not close” on page 86
- “Poor copy quality” on page 87
- “Partial document or photo copies” on page 88

**Copier does not respond**

These are possible solutions. Try one or more of the following:

**Check messages**

If an error message is displayed, see “Error messages” on page 94.

**Check power**

If the light is not on, see “Power button is not lit” on page 78.

**Removing and reinstalling software**

For more information, see “Removing and reinstalling the software” on page 100.

**Scanner unit does not close**

1. Lift the scanner unit.
2. Remove any obstruction keeping the scanner unit open.
3. Lower the scanner unit.
Poor copy quality

- Blank pages
- Checkerboard pattern
- Distorted graphics or pictures
- Missing characters
- Faded print
- Dark print
- Skewed lines
- Smudges
- Streaks
- Unexpected characters
- White lines in print

These are possible solutions. Try one or more of the following:

**Check messages**
If an error message is displayed, see “Error messages” on page 94.

**Check ink**
Check the ink levels, and install a new print cartridge if necessary.

**Clean the scanner glass**
If the scanner glass is dirty, gently wipe it with a clean, lint-free cloth dampened with water.

**Review steps to improve print quality**
See “Improving print quality” on page 72.

**Adjust the brightness of the copy**
1. Load the document facedown on the scanner glass.
2. From the control panel, press **Copy Mode**.
3. Press **Lighter/Darker**.
4. Press or repeatedly to lighten or darken the copy.
5. Press **Start Color** or **Start Black**.

**Check quality of original document**
If the quality of the original document is not satisfactory, try using a clearer version of the document or image.

**Are you scanning from photo or glossy paper, a magazine, or a newspaper?**
If you are copying or scanning from photo or glossy paper, a magazine, or a newspaper, see “Removing wavy patterns from scanned photos, magazines, or newspapers” on page 66.

**Check document placement**
Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.
Partial document or photo copies
These are possible solutions. Try one or more of the following:

Check document placement
Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.

Check paper size
Make sure the paper size being used matches the size you selected.

Check Original Size setting
Make sure that the Original Size setting is Automatic or the size of the original document that you are copying.

Scan troubleshooting
- “Scanner does not respond” on page 88
- “Scan was not successful” on page 89
- “Scanning takes too long or freezes the computer” on page 89
- “Poor scanned image quality” on page 89
- “Partial document or photo scans” on page 90
- “Cannot scan to a computer over a network” on page 90

Scanner does not respond
These are possible solutions. Try one or more of the following:

Check messages
If an error message is displayed, see “Error messages” on page 94.

Check power
If the light is not on, see “Power button is not lit” on page 78.

Check printer default and pause settings
1. Click:
   - In Windows XP (default Start menu): Start → Printers and Faxes.
   - In Windows XP (Classic Start menu): Start → Settings → Printers and Faxes.
   - In Windows Vista (default Start menu): Control Panel → Printers (under Hardware and Sound).
   - In Windows Vista (Classic Start menu): Settings → Printers.
2. Double-click the print queue device.
3. Click Printer.
   - Make sure no check mark appears next to Pause Printing.
   - If a check mark does appear next to Set As Default Printer, you must select the print queue device for each file you want to print.

Removing and reinstalling the software
For more information, see “Removing and reinstalling the software” on page 100.
Scan was not successful
These are possible solutions. Try one or more of the following:

Check USB cable connection
1 Check the USB cable for any obvious damage.
2 Firmly plug the square end of the USB cable into the back of the printer.
3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the USB symbol.

Restart computer
Turn off and then restart your computer.

Uninstall and reinstall software
For more information, see “Removing and reinstalling the software” on page 100.

Scanning takes too long or freezes the computer
These are possible solutions. Try one or more of the following:

Close other software
Close all programs not being used.

Change the scanning resolution to a lower value
1 Load an original document facedown on the scanner glass.
2 From the desktop, double-click the Lexmark Imaging Studio icon.
3 From the left pane of the Welcome screen, click Scan.
4 Click Custom Settings.
5 Select a lower scan resolution.
6 Click Start.

Poor scanned image quality
These are possible solutions. Try one or more of the following:

Check messages
If an error message is displayed, see “Error messages” on page 94.

Clean the scanner glass
If the scanner glass is dirty, gently wipe it with a clean, lint-free cloth dampened with water.

Adjust the quality of the scan
1 Load an original document facedown on the scanner glass.
2 From the desktop, double-click the Lexmark Imaging Studio icon.
3 From the left pane of the Welcome screen, click Scan.
4 Click **Custom Settings**.
5 Select a higher scan resolution.
6 Click **Start**.

**Review steps to improve print quality**
See “Improving print quality” on page 72.

**Are you scanning from photo or glossy paper, a magazine, or a newspaper?**
If you are copying or scanning from photo or glossy paper, a magazine, or a newspaper, see “Removing wavy patterns from scanned photos, magazines, or newspapers” on page 66.

**Check quality of original document**
If the quality of the original document is not satisfactory, try using a clearer version of the document or image.

**Check document placement**
Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.

**Partial document or photo scans**
These are possible solutions. Try one or more of the following:

**Check document placement**
Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.

**Check paper size**
Make sure the paper size being used matches the size you selected.

**Check Original Size setting**
Make sure the Original Size setting is **Auto Detect** or the size of the original document you are scanning.

**Cannot scan to a computer over a network**
See “Scanning to a computer over a network” on page 63.

**Jams and misfeeds troubleshooting**
- “Paper jam in the printer” on page 90
- “Paper jam in the paper support” on page 91
- “Paper or specialty media misfeeds” on page 91
- “Printer does not feed paper, envelopes, or specialty media” on page 91
- “Banner paper jams” on page 92

**Paper jam in the printer**
Remove the paper manually
1 Press 🍀 to turn off the printer.
2 Firmly grasp the paper, and gently pull it out.
3 Press \( \text{\textregistered} \) to turn the printer back on.

**Paper jam in the paper support**

1 Press \( \text{\textregistered} \) to turn off the printer.

2 Firmly grasp the paper, and gently pull it out.

3 Press \( \text{\textregistered} \) to turn the printer back on.

**Paper or specialty media misfeeds**

These are possible solutions if paper or specialty media misfeeds or skews, or if multiple sheets feed or stick together. Try one or more of the following:

**Check paper condition**

Use only new, unwrinkled paper.

**Check paper loading**

- Load a smaller amount of paper into the printer.
- Load paper with the print side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)

See “Loading various paper types” on page 34 for information about:

- Maximum loading amounts per paper type
- Specific loading instructions for supported paper and specialty media

**Remove each page as it is printed**

Remove each page as it exits, and let it dry completely before stacking.

**Adjust the paper guides**

Adjust the paper guides:

- When using media less than 8.5 inches wide
- To rest against the edges of the paper or media, making sure it does not buckle

**Printer does not feed paper, envelopes, or specialty media**

These are possible solutions. Try one or more of the following:

**Check for paper jams**

Check for and clear any paper jams. For more information, see “Paper jam in the printer” on page 90 and “Paper jam in the paper support” on page 91.
Check media loading
- Verify that the specialty media is loaded correctly. For more information, see “Loading various paper types” on page 34.
- Try loading one page, envelope, or sheet of specialty media at a time.

Check printer default and pause settings
1. Click:
   - In Windows XP (default Start menu): Start → Printers and Faxes.
   - In Windows XP (Classic Start menu): Start → Settings → Printers and Faxes.
   - In Windows Vista (default Start Menu): Control Panel → Printers (under Hardware and Sound).
   - In Windows Vista (Classic Start menu): Settings → Printers.
2. Double-click the print queue device.
3. Click Printer.
   - Make sure no check mark appears next to Pause Printing.
   - If a check mark does not appear next to Set As Default Printer, you must select the print queue device for each file you want to print.

Banner paper jams
There are possible solutions. Try one or more of the following:

Clear banner paper jams
1. Press \( \) to turn off the printer.
2. Remove the jammed banner paper from the printer.

Review banner printing checklist
- Use only the number of sheets needed for the banner.
- Select the following settings to enable the printer to feed paper continuously without jamming:
  1. With a document open, click File → Print.
  2. Click Properties, Preferences, Options, or Setup.
  3. Select the Paper Setup tab.
  4. From the Paper Size area, select Banner.
  5. Select Letter Banner or A4 Banner as the paper size.
  6. Select Portrait or Landscape.
  7. Click OK.
  8. Click OK or Print.

Memory card troubleshooting
- “Memory card cannot be inserted” on page 93
- “Nothing happens when memory card is inserted” on page 93
Memory card cannot be inserted

There are possible solutions. Try one or more of the following:

Check memory card type
Make sure that the type of memory card you are using can be used in the printer. For more information, see "Inserting a memory card" on page 44.

Check memory card placement
Make sure you have inserted the memory card in the correct slot. For more information, see “Inserting a memory card” on page 44.

Nothing happens when memory card is inserted

These are possible solutions. Try one or more of the following:

Reinsert the memory card
The memory card may have been inserted too slowly. Remove and then reinsert the memory card quickly.

Check memory card placement
Make sure you have inserted the memory card in the correct slot. For more information, see “Inserting a memory card” on page 44.

Check memory card type
Make sure that the type of memory card you are using can be used in the printer. For more information, see “Inserting a memory card” on page 44.

Check to see if the memory card is damaged
Check that there is no obvious damage to the memory card.

Check to see if the memory card contain photos
Insert a memory card that contains photos. The printer will read photos created using the JPEG format. For more information, see the documentation that came with the digital camera.

Make sure the USB cable is connected

1. Check the USB cable for any obvious damage.
2. Firmly plug the square end of the USB cable into the back of the printer.
3. Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the USB symbol.
Error messages

Alignment Error
These are possible solutions. Try one or more of the following:

Remove tape from print cartridge

1. Remove the print cartridge.
2. Make sure the sticker and tape have been removed.

3. Reinsert the cartridge.
4. Press √ to align the cartridge.
   For more information, see “Aligning print cartridges” on page 72.

Use new paper
Load only plain, unmarked paper for aligning the cartridge.
The printer will read any markings on used paper, which could cause the alignment error message to appear.

Black Ink Low / Color Ink Low / Photo Ink Low

1. Check the indicated ink level or levels, and install a new print cartridge or cartridges if necessary.
   To order supplies, see “Ordering supplies” on page 74.
2. Press √ to continue.

Cartridge Error (1102, 1203, 1204, or 120F)

1. Remove the print cartridges, and close the cartridge carrier lids.
2. Disconnect the power cord from the electrical outlet.
3. Reconnect the power cord to the electrical outlet.
4. If the button is not lit, press .
5. Reinsert the print cartridges.
If the error does not reappear, the problem has been corrected.
If the problem reappears, one of the cartridges is not working properly. Continue with the following procedure to determine which cartridge is not working properly.

1. Remove the print cartridges, and close the cartridge carrier lids.
2. Disconnect the power cord from the electrical outlet.
3. Reconnect the power cord to the electrical outlet.
4. If the button is not lit, press .
5 Reinsert the black (or photo) print cartridge.

6 If the error:
   • Reappears, replace the black (or photo) print cartridge with a new one.
   • Does not reappear, reinsert the color print cartridge.

7 If the error reappears, replace the color print cartridge with a new one.

Clear Carrier Jam
These are possible solutions. Try one or more of the following:

Remove any obstructions

1 Raise the scanner unit.

2 Remove any objects blocking the path of the print cartridge carrier.

3 Make sure the cartridge carrier lids are closed.

4 Close the scanner unit.

5 Press √.

Remove print cartridges

1 Make sure the printer is on.

2 Raise the scanner unit.

3 Remove both print cartridges.

4 Make sure the cartridge carrier lids are closed.

5 Close the scanner unit.

6 Press ⬅️ to turn the printer off.

7 Disconnect the power cord from the wall outlet.

8 Plug the power cord back into the wall outlet.

9 Press ⬅️ to turn the printer on.
10 Reinstall the print cartridges. For more information, see “Installing print cartridges” on page 70.

11 Close the scanner unit.

12 Plug the power cord into the wall outlet.

13 Press  to turn the printer on.

14 Reinstall the print cartridges. For more information, see “Installing print cartridges” on page 70.

**Computer not connected**

These are possible solutions. Try one or more of the following:

**Check computer connection**

Make sure your computer is connected to the printer and is turned on.

**Check USB cable**

1 Check the USB cable for any obvious damage.

2 Firmly plug the square end of the USB cable into the USB port on the back of the printer.

3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

   The USB port is marked with the USB symbol.

**Check external print server**

If you are using an external print server, make sure it is connected. For more information, see the print server documentation.

**Could not detect a proof sheet**

The document placed on the scanner glass is not a valid proof sheet. For more information, see “Printing photos stored on a memory device using the proof sheet” on page 49.

**Error 1104**

1 Remove the print cartridges.

2 Reinstall the black cartridge or the photo cartridge in the left carrier.

3 Reinstall the color cartridge in the right carrier.
Left Cartridge Error / Right Cartridge Error
This message may also appear as Error 1205 (Left Cartridge) or Error 1206 (Right Cartridge).

1. Remove the indicated print cartridge.
2. Disconnect the power cord from the electrical outlet.
3. Reconnect the power cord to the electrical outlet.
4. If the button is not lit, press .
5. Reinsert the print cartridge.
6. If the error:
   • Does not reappear, the problem has been corrected.
   • Reappears, replace the print cartridge with a new one.

Left Cartridge Incorrect / Right Cartridge Incorrect
1. Remove the indicated print cartridge.
2. Disconnect the power cord from the electrical outlet.
3. Reconnect the power cord to the electrical outlet.
4. If the button is not lit, press .
5. Reinsert the print cartridge.
6. If the error:
   • Does not reappear, the problem has been corrected.
   • Reappears, replace the print cartridge with a new one.

Left Cartridge Missing / Right Cartridge Missing
One or both print cartridges are missing or not installed properly. For more information, see “Installing print cartridges” on page 70.

Notes:
• You can make a color copy with only the color cartridge installed.
• You can print a black-and-white document with only the black cartridge installed.
• You cannot copy or print when only the photo cartridge is installed.
• To remove the error message, press .

Memory Failure
These are possible solutions. Try one or more of the following:

Reduce memory use
If applicable:
• Print pending received faxes.
• Send fewer pages.
Select the After Dial setting
1 From the desktop, double-click the Lexmark Imaging Studio icon.
2 From the left pane of the Welcome screen, click Setup and manage faxes.
3 Click Adjust speed dial list and other fax settings.
4 Click the Dialing and Sending tab.
5 From the “Sending options” area, select After Dial from the “When to scan document” section.
6 Click OK.
7 Resend the fax.

No images have been selected
You have not selected any of the options on step 1 of the photo proof sheet you printed and scanned.
1 Make sure you completely fill in your selected circle or circles.
2 Press X to continue.

No photo/paper size selection has been made
You have not selected any of the options on step 2 of the photo proof sheet you printed and scanned.
1 Make sure you completely fill in your selected circle or circles.
2 Press X to continue.

No proof sheet information
The photo proof sheet you printed and scanned is no longer valid.
You may have removed the memory card or flash drive from the printer, or turned off the printer, before scanning the photo proof sheet.
For more information, see “Printing photos stored on a memory device using the proof sheet” on page 49.

No valid photo image files detected
No supported images have been found on the memory card or flash drive.
The printer will read photos created using the JPEG format. For more information, see the documentation that came with the digital camera.

Only one photo enhancement may be chosen at a time
You have selected more than one option on step 2 of the photo proof sheet you printed and scanned.
1 Make sure you completely fill in only one circle for each option.
2 Press X to continue.

Only one photo/size selection can be chosen at a time
You have selected more than one option on step 2 of the photo proof sheet you printed and scanned.
1 Make sure you completely fill in only one circle for each option.
2 Press X to continue.
Photo size error. Photo must fit on page.
There are one or more photos larger than the paper size you selected on the printer menu.

1 Press \( \times \) to clear the error message.
2 Press \( \leftarrow \) or \( \rightarrow \) repeatedly until Paper Size appears on the display.
3 Press \( \checkmark \).
4 Press \( \leftarrow \) or \( \rightarrow \) repeatedly to select the paper size option that will fit your largest photo size.
5 Press Start Color or Start Black to begin printing.

PictBridge communications error
Remove and then reinsert the USB cable that came with the camera into the PictBridge port on the front of the printer. For more information, see “Using a PictBridge-enabled digital camera to control printing photos” on page 52.

Please remove the camera card.
The printer can read either a PictBridge-enabled digital camera or a memory card, but not both at the same time.

1 Remove both the PictBridge-enabled digital camera and the memory card.
2 Reinsert only one of the devices mentioned above.

Some photos removed from card by host.
Some of the photos on the photo proof sheet were deleted from the memory card through the computer. You must print a new photo proof sheet.
For more information, see “Printing photos stored on a memory device using the proof sheet” on page 49.

There is a problem reading the memory card.
• See “Memory card cannot be inserted” on page 93.
• See “Nothing happens when memory card is inserted” on page 93.

Settings are not saved
These are possible solutions. Try one or more of the following:

Change time-out settings
If you press \( \checkmark \) to select a setting, an * appears next to the selected setting. The printer reverts to the default setting after two minutes of inactivity or if the printer is turned off. For information on how to change this time-out feature, see “Saving settings” on page 25.

Save settings for future jobs
If you press \( \checkmark \) to select a setting, an * appears next to the selected setting. For information on how to save the setting for future jobs, see “Saving settings” on page 25.

Resetting to factory default settings
You can reset your printer to the original settings without using the printer menus.
Note: Resetting to factory default settings will delete all printer settings you selected.

1 Press \( \bigcirc \) to turn off the printer.

2 Press and hold the **Settings** and **Start Color** buttons at the same time, then press again \( \bigcirc \) to turn the printer back on.

   *Language* appears on the display, indicating that the printer has been reset.

3 Press \( \leftarrow \) or \( \rightarrow \) until the language you want appears.

4 Press \( \checkmark \).

5 Press \( \leftarrow \) or \( \rightarrow \) until the country or region you want appears.

6 Press \( \checkmark \).

## Removing and reinstalling the software

If the printer is not functioning properly, or if a communications error message appears when you try to use the printer, you may need to remove and reinstall the printer software.

1 Click **Start** → **Programs** or **All Programs** → **Lexmark 3500-4500 Series**.

2 Select **Uninstall**.

3 Follow the instructions on the computer screen to remove the printer software.

4 Restart the computer before reinstalling the printer software.

5 Click **Cancel** on all New Hardware Found screens.

6 Insert the CD, and then follow the instructions on the computer screen to reinstall the software.

   *Note:* If the install screen does not appear automatically after you restart your computer, click **Start** → **Run**, and then type `D:\setup`, where `D` is the letter of your CD-ROM drive.

If the software still does not install correctly, visit our Web site at [www.lexmark.com](http://www.lexmark.com) to check for the latest software.

1 In all countries or regions except the United States, select your country or region.

2 Click the links for drivers or downloads.

3 Select your printer family.

4 Select your printer model.

5 Select your operating system.

6 Select the file you want to download, and then follow the directions on the computer screen.
Notices

Product name:
Lexmark 3500 Series
Machine type:
4431
Model(s):
001, 003

Product name:
Lexmark 4500 Series
Machine type:
4431
Model number 2:
W02, W0E, W0J, W12, W1E, W1J

Edition notice

March 2007

The following paragraph does not apply to any country where such provisions are inconsistent with local law: LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in later editions. Improvements or changes in the products or the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make these available in all countries in which it operates. Any reference to a product, program, or service is not intended to state or imply that only that product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification of operation in conjunction with other products, programs, or services, except those expressly designated by the manufacturer, are the user’s responsibility.

For Lexmark technical support, visit support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

If you don’t have access to the Internet, you can contact Lexmark by mail:

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550

© 2007 Lexmark International, Inc.
All rights reserved.

UNITED STATES GOVERNMENT RIGHTS

This software and any accompanying documentation provided under this agreement are commercial computer software and documentation developed exclusively at private expense.

Trademarks

Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the United States and/or other countries.
PerfectFinish is a trademark of Lexmark International, Inc.
All other trademarks are the property of their respective owners.

Conventions

Note: A Note identifies something that could help you.
Warning: A Warning identifies something that could damage your product hardware or software.

**CAUTION:** A CAUTION identifies something that could cause you harm.

This type of CAUTION indicates that you should not touch the marked area.

This type of CAUTION indicates a hot surface.

This type of CAUTION indicates a shock hazard.

This type of CAUTION indicates a tipping hazard.

The following notices are applicable if your printer has a wireless network card installed

Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

**Note:** Some modes may not apply to your product.

<table>
<thead>
<tr>
<th>1-meter average sound pressure, dBA</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>50</td>
</tr>
<tr>
<td>Scanning</td>
<td>40</td>
</tr>
<tr>
<td>Copying</td>
<td>50</td>
</tr>
<tr>
<td>Ready</td>
<td>38</td>
</tr>
</tbody>
</table>

Values are subject to change. See [www.lexmark.com](http://www.lexmark.com) for current values.

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the Lexmark Web site at [www.lexmark.com](http://www.lexmark.com) for your local sales office phone number.
Power consumption

Product power consumption

The following table documents the power consumption characteristics of the product.  
Note: Some modes may not apply to your product.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>Power consumption (Watts)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>The product is generating hard-copy output from electronic inputs.</td>
<td>Lexmark 3500 Series: 15; Lexmark 4500 Series: 18</td>
</tr>
<tr>
<td>Copying</td>
<td>The product is generating hard-copy output from hard-copy original documents.</td>
<td>Lexmark 3500 Series: 13; Lexmark 4500 Series: 16</td>
</tr>
<tr>
<td>Scanning</td>
<td>The product is scanning hard-copy documents.</td>
<td>Lexmark 3500 Series: 10; Lexmark 4500 Series: 13</td>
</tr>
<tr>
<td>Ready</td>
<td>The product is waiting for a print job.</td>
<td>Lexmark 3500 Series: 8; Lexmark 4500 Series: 11</td>
</tr>
<tr>
<td>Power Saver</td>
<td>The product is in energy-saving mode.</td>
<td>Lexmark 3500 Series: 5.0; Lexmark 4500 Series: 7.7</td>
</tr>
<tr>
<td>High Off</td>
<td>The product is plugged into a wall outlet, but the power switch is turned off.</td>
<td>not applicable</td>
</tr>
<tr>
<td>Low Off (&lt;1 W Off)</td>
<td>The product is plugged into a wall outlet, the power switch is turned off, and the product is in the lowest possible power consumption mode.</td>
<td>not applicable</td>
</tr>
<tr>
<td>Off</td>
<td>The product is plugged into a wall outlet, but the power switch is turned off.</td>
<td>0.3</td>
</tr>
</tbody>
</table>

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous power draws may be substantially higher than the average.  
Values are subject to change. See www.lexmark.com for current values.

Power Saver

This product is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent to the EPA Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended periods of inactivity. The Power Saver Mode is automatically engaged after this product is not used for a specified period of time, called the Power Saver Timeout.

Factory default Power Saver Timeout for this product (in minutes): 60

Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product power consumption, disconnect the power supply cord from the wall outlet.

Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.
End-user license agreement*

Opening this package, installing the printing device software, or using the print cartridges inside, confirms your acceptance of the following license/agreement: The patented print cartridges contained inside are licensed for a single use only and is/are designed to stop working after delivering a fixed amount of ink. A variable amount of ink will remain in the cartridge when replacement is required. After this single use, the license to use the print cartridge terminates, and the used cartridge must be returned only to Lexmark for remanufacturing, refilling or recycling. If you do not accept the terms of this single use license/agreement, return this product in its original packaging to your point of purchase. A replacement cartridge sold without these terms is available at www.lexmark.com.

* Products within the XX80 Series (including but not limited to Models X1380, X1480, X1580, X2580, X3580, and X4580) are not subject to this license agreement.
Index

A
Advanced tab 30
aligning print cartridges 72
alignment error 94

B
banner paper jams 92
banner paper, loading 37
black ink low 94
borderless copying
using the control panel 58
box contents 12
buttons, control panel
Back 18
Cancel 18
Copy Mode 18
Left arrow 18
Lighter / Darker 18
Menu 18
Photo Card 18
Power 17
Right arrow 18
Scan Mode 18
Select 18
Settings 18
Start Black 19
Start Color 19
buttons, Lexmark Imaging Studio
Copy 27
E-mail 27
Fax 27
Photo Greeting Cards 27
Photo Packages 27
Poster 27
Scan 27
Slideshow 27
Transfer Photos 27
using 27
View / Print Photo Library 27

cartridges, print
aligning 72
cleaning 72
installing 70
ordering 74
preserving 74
removing 70
wiping 73
CD
printing photos from 54
transferring all photos using the
computer 47
transferring selected photos using
the computer 48
cleaning print cartridge nozzles 72
collating copies 41, 59
color ink low 94
computer not connected error 96
Contact Information tab 29
contents, box 12
control panel 16
Copy menu 19
installing another language 13
Photo Card menu 21
PictBridge menu 22
saving settings 25
Scan menu 20
Settings menu 23
using 17
copier does not respond 86
Copy button 27
Copy menu 19
copy quality, adjusting 57
copy troubleshooting
copier does not respond 86
partial document or photo
copies 88
poor copy quality 87
scanner unit does not close 86
copying 57
adjusting quality 57
borderless photos 58
cloning an image 60
collating copies 59
customizing settings 19
enlarging an image 60
making a copy lighter or
darker 59
photos 58
reducing an image 60
repeating an image 60
copying a document 61
copying a photo 62
could not detect a proof sheet 96
customizing settings
copy 19
scan 20
custom-size paper, loading 36

d
defaults
Photo Card menu 21
resetting factory defaults 99
Scan menu 20
Settings menu 23
descreening 66
document
copying 61
documents
attaching to e-mail 66
e-mailing 66
faxing using the software 68
loading on scanner glass 37
printing 39
scanning images for editing 65
scanning text for editing 64
scanning using the computer 64
scanning using the control
panel 63

e
editing
document text (OCR) 64
scanned images 65
emission notices 102
enlarging an image 60
envelopes
loading 35
printing 41
error 1104 96
error 1205 97
error 1206 97
error messages
alignment error 94
black ink low 94
cartridge error 94
clear carrier jam 95
color ink low 94
computer not jam 96
could not detect a proof sheet 96
error 1104 96
error 1205 97
error 1206 97
left cartridge error 97
left cartridge incorrect 97
left cartridge missing 97
memory full 97
no images have been
selected 98
no photo/paper size selection has
been made 98
no proof sheet information 98
no valid photo image files
detected 98
only one photo enhancement may
be chosen at a time 98
only one photo/size selection can
be chosen at a time 98
photo ink low 94
photo size error 99
PictBridge communications
error 99
please remove the camera
card 99
problem reading memory
card 99
right cartridge error 97
right cartridge incorrect 97
right cartridge missing 97
some photos removed from card
by host 99
E-mail button 27
e-mailing an image 66

F
factory default settings, resetting
to 99
fax
receiving automatically 69
Fax button 27
faxing
using the software 68
finding
information about printer 9
MAC address 15
publications 9
Web site 9
flash drive
inserting 45
printing files from 43
printing photos using the proof
sheet 49
transferring all photos using the
computer 47
transferring selected photos using
the computer 48

g
Glossy paper, loading 34
greeting cards
  loading 36
  printing 42

H
Heavyweight matte paper,
loading 34
high-quality graphics, printing 39
How To tab 29

I
I Want To menu 31
images
e-mailing 66
improving print quality 72
incorrect language appears on
display 77
index cards
  loading 36
  printing 42
information, finding about printer 9
ink levels seem incorrect 85
ink levels seem to go down
quickly 86
ink levels, checking 28
ink, ordering 28
inserting
  flash drives 45
  memory cards 44
  PictBridge-enabled digital
camera 52
installing
  print cartridges 70
  printer on a network 14
  printer software 100
internal wireless print server
  installing 14
  iron-on transfers, loading 36

J
jams and misfeeds troubleshooting
  banner paper jams 92
  paper jam in the paper
  support 91
  paper jam in the printer 90
  paper or specialty media
  misfeeds 91
  printer does not feed paper,
envelopes, or specialty media 91

L
labels, loading 35
landscape orientation,
selecting 30
language
  changing 77
last page first 41
layout, selecting 30
left cartridge error 97
left cartridge incorrect 97
left cartridge missing 97
Lexmark Imaging Studio buttons
  Copy 27
  E-mail 27
  Fax 27
  Photo Greeting Cards 27
  Photo Packages 27
  Scan 27
  Slideshow 27
  Transfer Photos 27
  using 27
  View / Print Photo Library 27
Lexmark Imaging Studio, using 27
loading
  banner paper 37
  custom-size paper 36
  documents on the scanner
glass 37
  envelopes 35
  glossy paper 34
  greeting cards 36
  heavyweight matte paper 34
  index cards 36
  iron-on transfers 36
  labels 35
  paper 34
  photo cards 36
  photo paper 34
  photos on the scanner glass 37
  postcards 36
  transparencies 35

M
MAC address, finding 15
magazine articles, loading on the
scanner glass 37
maintenance menus
  Settings menu 23
Maintenance tab 29
media device
  printing photos using the
computer 54
memory card
  inserting 44
  printing files from 43
  printing photos using the proof
  sheet 49
transferring all photos using the computer  46
transferring selected photos using the computer  47
memory card cannot be inserted  93
memory card slots  16
memory card troubleshooting memory card cannot be inserted  93
nothing happens when memory card is inserted  93
memory full error message  97
moire patterns, removing from scanned images  66

N
network printer
installing  14
network scanning  63
networking
installing internal wireless print server  14
installing printer  14
newspapers, loading on the scanner glass  37
no images selected error  98
no photo/paper size error  98
no proof sheet information error  98
no valid photo image files detected  98
noise emission levels  102
nothing happens when memory card is inserted  93
notices  102, 103
N-up feature  42

O
OCR, editing document text  64
only one photo enhancement may be chosen at a time  98
only one photo/size selection can be chosen at a time  98
ordering paper and other supplies  75
orientation, changing
landscape  30
portrait  30

P
page does not print  79
paper and other supplies, ordering  75
paper exit tray  16
paper feed guard  16
paper guide  16
paper jam in the paper support  91
paper jam in the printer  90
paper or specialty media misfeeds  91
Paper Setup tab  30
paper sizes, specifying  30
paper support  16
paper, loading  34
partial 4x6in. (10x15cm) photo prints when using PictBridge  81
partial document or photo copies  88
partial document or photo prints  85
partial document or photo scans  90
parts
control panel  16
memory card slots  16
paper exit tray  16
paper feed guard  16
paper guide  16
paper support  16
PictBridge port  16
power supply port  17
print cartridge carrier  17
scanner glass  16
scanner unit  17
top cover  16
USB port  17
Wi-Fi indicator  16
Photo Card menu  21
photo cards, loading  36
Photo Greeting Cards button  27
photo ink low  94
Photo Library
printing photos  53
scanning a photo to  65
viewing photos  53
Photo Packages  54
Photo Packages button  27
photo paper, loading  34
photo size error  99
photo smudges  85
photos
copying  62
copying borderless photos  58
copying photos  58
loading on the scanner glass  37
printing all  50
printing by date range  51
printing by number  50
printing from a Web page  40
printing from digital camera using DPOF  52
printing from media device using the computer  54
printing from PictBridge-enabled digital camera  52
printing using color effects  51
printing using the proof sheet  49
scanning multiple photos at one time using computer  65
scanning to Photo Library  65
smudges, preventing  85
transferring all photos from CD or flash drive using the computer  47
transferring all photos from memory card using the computer  46
transferring from memory card to flash drive  48
transferring from memory device using control panel  46
transferring selected photos from CD or flash drive using the computer  48
transferring selected photos from memory card using the computer  47
photos removed from card by host  99
PictBridge communications error  99
PictBridge menu  22
PictBridge port  16
PictBridge-enabled camera, printing photos from  52
please remove the camera card  99
poor copy quality  87
poor quality at the edges of the page  84
poor scanned image quality  89
poor text and graphic quality  83
portrait orientation, selecting  30
postcards
loading  36
printing  42
Poster  56
Poster button  27
power button is not lit  78
power supply port  17
print cartridge carrier  17
print cartridge nozzles, cleaning  72
print cartridges
aligning 72
cleaning 72
installing 70
ordering 74
preserving 74
removing 70
wiping 73
print cartridges, ordering 28
Print Layout tab 30
Print Properties
I Want To menu 31
Options menu 31
print quality, improving 72
print speed is slow 85
print troubleshooting
improving print quality 82
ink levels seem incorrect 85
ink levels seem to go down quickly 86
partial 4x6in. (10x15cm) photo prints when using PictBridge 81
partial document or photo prints 85
photo smudges 85
poor quality at the edges of the page 84
poor text and graphic quality 83
print speed is slow 85
printer does not feed paper, envelopes, or specialty media 91
printer software
reinstalling 100
removing 100
using 27
printer software settings
resetting to defaults 32
Printer Status dialog 29
printing
all photos 50
cards 42
collated copies 41
document 39
envelopes 41
files from memory card or flash drive 43
greeting cards 42
high-quality graphics 39
index cards 42
last page first 41
multiple pages on one sheet 42
Photo Packages 54
photos by date range 51
photos by number 50
photos from digital camera using DPOF 52
photos from media device using the computer 54
photos from PictBridge-enabled digital camera 52
photos from the Photo Library 53
photos using color effects 51
photos using the proof sheet 49
postcards 42
Poster 56
reverse page order 41
transparencies 41
Web page 39
Web page, photos only 40
Printing Preferences
opening 30
Paper Setup tab 30
Print Layout tab 30
Printing Preferences tabs 30
Quality/Copies tab 30
Save Settings menu 31
problem reading memory card error 99
proof sheet, using 49
publications, finding 9
Q
Quality/Copies tab 30
R
receiving a fax automatically 69
recycling
Lexmark products 76
WEEE statement 102
reducing an image 60
removing print cartridges 70
repeating an image 60
reverse page order 41
right cartridge error 97
right cartridge incorrect 97
right cartridge missing 97
S
safety information 2
saving
paper size settings 22
paper type settings 22
photo size settings 22
Scan button 27
Scan menu 20
scan troubleshooting
cannot scan to computer over network 90
partial document or photo scans 90
poor scanned image quality 89
scan was not successful 89
scanner does not respond 88
scanning takes too long or freezes the computer 89
scan was not successful 89
scanner does not respond 88
scanner glass 16
cleaning 74
loading documents 37
scanner unit 17
scanner unit does not close 86
scanning
customizing settings 20
customizing settings using computer 67
editing images 65
editing text 64
from magazines and newspapers 66
multiple photos at one time using computer 65
over a network 63
photo to Photo Library 65
removing wavy (moire) patterns 66
to computer over a network 63
using the computer 64
using the control panel 63
scanning takes too long or freezes the computer 89
settings are not saved 99
Settings menu
Defaults 24
Device Setup 24
Maintenance 24
Paper Setup 23
settings, saving 25
setup troubleshooting
cannot print from digital camera using PictBridge 80
incorrect language appears on display 77
page does not print 79
power button is not lit 78
software does not install 78
smudging, preventing in photos 85
software
Lexmark Imaging Studio 27
Printing Preferences 30
removing and reinstalling 100
Solution Center 28
Toolbar 31
using 27
software does not install 78
software settings, printer resetting to defaults 32
Solution Center
Advanced tab 30
Contact Information tab 29
How To tab 29
Maintenance tab 29
opening 29
Printer Status dialog 29
Troubleshooting tab 29
using 28

T
Toolbar
printing a Web page 39
printing only the photos from a Web page 40
using 31
top cover 16
Transfer Photos button 27
transferring photos
from CD using the computer 47, 48
from flash drive using the computer 47, 48
from memory card to flash drive 48
from memory card using the computer 46, 47
from memory device using control panel 46
transparencies
loading 35
printing 41
Troubleshooting tab 29
troubleshooting, copy copier does not respond 86
partial document or photo copies 88
poor copy quality 87
scanner unit does not close 86
troubleshooting, error messages
alignment error 94
black ink low 94
cartridge error 94
clear carrier jam 95
color ink low 94
computer not connected 96
could not detect a proof sheet 96
error 1104 96
error 1205 97
error 1206 97
left cartridge error 97
left cartridge incorrect 97
left cartridge missing 97
memory full 97
no images have been selected 98
no photo/paper size selection has been made 98
no proof sheet information 98
no valid photo image files detected 98
only one photo enhancement may be chosen at a time 98
only one photo/paper size selection can be chosen at a time 98
photo ink low 94
photo size error 99
PictBridge communications error 99
please remove the camera card 99
problem reading memory card 99
right cartridge error 97
right cartridge incorrect 97
right cartridge missing 97
some photos removed from card by host 99
troubleshooting, jams and misfeeds
banner paper jams 92
paper jam in the paper support 91
paper jam in the printer 90
paper or specialty media misfeeds 91
printer does not feed paper, envelopes, or specialty media 91
troubleshooting, memory card memory card cannot be inserted 93
nothing happens when memory card is inserted 93
troubleshooting, print
improving print quality 82
ink levels seem incorrect 85
ink levels seem to go down quickly 86
partial 4x6in. (10x15cm) photo prints when using PictBridge 81
partial document or photo prints 85
photo smudges 85
poor quality at the edges of the page 84
poor text and graphic quality 83
print speed is slow 85
troubleshooting, scan
cannot scan to computer over network 90
partial document or photo scans 90
poor scanned image quality 89
scan was not successful 89
scanner does not respond 88
scanning takes too long or freezes the computer 89
troubleshooting, setup
cannot print from digital camera using PictBridge 80
incorrect language appears on display 77
page does not print 79
power button is not lit 78
software does not install 78

U
USB port 17

V
View / Print Photo Library button 27
viewing photos in the Photo Library 53

W
Web page
printing 39
printing only the photos 40
Web site
finding 9
Wi-Fi indicator 16